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1 INTRODUCTION 
This document contains instructions for the installation of FileNet Email Manager (eMgr). For each 
component required by Email Manager, the following sections may be included:  

• Pre-requisite Activities: contains instructions for activities that must be performed prior to the 
actual installation of the software. These activities involve preparing the systems for the software 
and do not require any Email Manager components.  

• Installation: contains instructions for installing Email Manager specific components. 

1.1 Implementation Worksheet 
To assist with the installation, an Implementation Worksheet on which information required for the 
installation can be recorded is provided in Appendix A. Throughout this guide you will see values 
highlighted in bold text. These bold typeface values should be entered in the appropriate location on the 
Implementation Worksheet. These bold types values will be referenced in the document as bold text. 

Prior to beginning the installation, record the version numbers of the various software applications that will 
be used in the Implementation Worksheet in the section Software Versions. 

1.2 Assumptions 
The instructions in this Setup Guide assume the administrator installing the software is knowledgeable 
about Windows server administration, FileNet Content Services/Images Services /P8 Content Engine 
administration, either Microsoft Exchange or Lotus Domino administration and either Oracle or SQL 
Server administration. 

1.3 New Features  
This following is a summary of new features in Email Manager 3.7: 

• GroupWise Connector:  a source connector that will capture emails in a Novell GroupWise 
system. 

• GroupWise Client integration: support for manual capture of email from the Novell GroupWise 
Client. 

• Group Rules: in rules, the option to determine whether a user in the email recipient’s field is a 
member of a specific LDAP group. Active Directory, eDirectory and SunOne are supported. 

• High availability support: support for an active/passive cluster server installation of Email 
Manager Server. As well, support for symmetrical server configuration is included. 

• FaceTime IMAuditor support: certified for use with FaceTime’s IMAuditorTM product for the 
purpose of capturing instant messages and importing them into a FileNet repository.  

• VMWare ESX Server support: certified for use with VMWare ESX Server 

• Citrix Metaframe support: Email Manager Server certified for use with Citrix Metaframe. 
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2 SYSTEM REQUIREMENTS 
The following sections describe the system requirements for Email Manager.  

2.1.1 Dependant Systems Requirements 
Email Manager requires a database server, an email server, an email client and a document repository. 
The following systems are supported by Email Manager.  

Database 

Database Server Version(s) 

Microsoft SQL Server 2000 

Oracle  8i, 9i, 10g 

 

Email Server 

Email Server Version(s) 

Microsoft Exchange Server 2000, 2003 

Lotus Domino 6.0.2 to 6.5.5, 7.0 

GroupWise 6.5.5 to 6.5.6, 7.0 SP1 

 

Email Client 

Email Client Version(s) 

Outlook 2000, 2002, 2003 

Lotus Notes 6.0.2 to 6.5.5, 7.0 

GroupWise 6.5.5 to 6.5.6, 7.0 SP1 

 

Document Repository 

Document Repository Server Version(s) 

FileNet Content Services 5.2, 5.3, 5.4 

FileNet Image Services 3.6, 4.0 

FileNet P8 Content Engine 3.0, 3.5, 3.5.1, 3.5.2 

FileNet Records Manager 3.5, 3.5.1 

For Records Manager 3.5.x, no default permissions are granted for 
Records Classes. The permissions must be explicitly set, otherwise 
“access denied” error will occur when Email Manager attempts to 
declare a record. See the section Document Repository 
Configuration for details on how to configure Records Manager for 
use with Email Manager. 
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2.1.2 Email Manager Server Requirements 
The following software must be installed on the server Email Manager is installed on: 

• Windows 2000 Pro, Windows 2000 Server, Windows XP Pro, Windows 2003 Server 

• .Net Framework 1.1 required 

• If Email Manager Web Services will be used (required for Email Manager Client integration), 
one of: 

o Internet Information Server 5.0 

o Internet Information Server 6.0 

• If Exchange Server is being used as the email server, one of: 

o Outlook 2000 w/ CDO 

o Outlook 20021 w/ CDO 

o Outlook 2003 w/ CDO 

• If Lotus Domino is being used as the email server, one of:  

o Lotus Notes 6.0.2 to 6.5.5. Note: to support DXL file and shortcut options, 
Lotus Notes 6.0.3 client or higher is required. 

o Lotus Notes 7.0 

• If GroupWise is being used as the email server, one of: 

o GroupWise Client 6.5.5 to 6.5.6 for Windows 

o GroupWise Client 7.0 SP1 for Windows 

o Note: in addition, Windows Scripting 5.6 or higher is required on the machine. It 
can be found at: 
http://www.microsoft.com/downloads/details.aspx?FamilyID=c717d943-7e4b-
4622-86eb-95a22b832caa&DisplayLang=en 

• If Oracle is being used as the database server, one of: 

o Oracle 8i Client 

o Oracle 9i Client 

o Oracle 10g Client 

• If FileNet Content Services is being used as the document repository, one of: 

o Panagon Desktop 3.x and client libraries 

o Panagon Web 3.x and client libraries 

• If FileNet Image Services is being used as the document repository: 

o Panagon Web 3.x and client libraries 

• If FileNet P8 Content Engine is being used as the document repository: 

o FileNet P8 Content Engine COM SDK 
                                                      
1 On the eMgr Server, Microsoft Office Service Pack 2 should not be installed. When using Service Pack 
2, the eMgr Exchange Connector may not be able to establish a connection to the Exchange Server. 
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o FileNet P8 Client Connectivity 

• If FileNet Records Manager is being used: 

o Java Platform Standard Edition 1.4.2 

2.1.3 Email Manager Client Requirements 
The following software must be installed on the client machine Email Manager Client is installed on: 

• Windows 2000 Pro, Windows XP Pro 

• If Exchange Server is being used as the email server, one of: 

o Outlook 2000 

o Outlook 2002 

o Outlook 2003 

• If Lotus Domino is being used as the email server, one of:  

o Lotus Notes 6.0.23 to 6.5.5 

o Lotus Notes 7.0 

• If GroupWise is being used as the email server, one of: 

o GroupWise Client 6.5.5 to 6.5.6 for Windows 

o GroupWise Client 7.0 SP 1 for Windows 

o Note: in addition, Windows Scripting 5.6 or higher is required on the machine. It 
can be found at: 
http://www.microsoft.com/downloads/details.aspx?FamilyID=c717d943-7e4b-
4622-86eb-95a22b832caa&DisplayLang=en 

 

                                                      
3 To import DXL files (Lotus Notes native format for email), Lotus Notes 6.0.3 or higher is required. Only 
email in plain text format is supported for versions of Lotus Notes older than 6.0.3. 
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3 BEFORE INSTALLING 
The following activities should be performed before installing Email Manager server components. 

Email Manager components should not be installed on a machine that is a domain controller. Some .Net 
and Web Services components may not function as expected on a domain controller. 

If Email Manager for Exchange is being used, the server Email Manager is installed on must either be on 
the same domain as the Exchange Server or the domains should be configured such that an Outlook 
client on the Email Manager Server machine can connect to Exchange by using only NT authentication 
(in other words, a login prompt should not be shown when connecting to Exchange). 

If P8 Content Engine is being used, the server Email Manager is installed on must be on the same 
domain as the P8 Content Engine server. 

The setup required in this section assumes the administrator is knowledgeable about Windows server 
administration, Exchange/Lotus Notes administration, and FileNet CS/FileNet P8 Content Engine 
administration.  

3.1 Document Repository Configuration 
This section describes configuration required in the Document Repository to support Email Manager. 

3.1.1 FileNet Content Services 
The setup required in this section assumes the administrator is knowledgeable about FileNet Content 
Services administration. 

3.1.1.1 Collect Library Information 
In the Implementation Worksheet, enter the following information in the section FileNet Content Services 
under the settings specified. 

1. Under FileNet Content Services Version, enter the version of Content Services being used. 

2. Under Panagon Desktop Version, enter the version of Panagon Desktop being used. 

3. Under Operating System, enter the name and version of the operating system Content Services 
resided on. 

4. Under Library System, enter the library system name (library name) 

5. Under Library Server, enter the name of the library server (host) 

3.1.1.2 Document Class/Custom Property Setup 
Document classes and custom properties required are dependent on the business requirements for email 
indexing.  Any document classes and custom properties required should be created prior to Email 
Manager setup and configuration. See the section APPENDIX B: DOCUMENT CLASS 
CONFIGURATION for suggestions for custom property configuration. 

 

Email Manager 3.7 Setup Guide     7 



 

3.1.1.3 User Creation 
A user in the FileNet library needs to be created for Email Manager to use when adding email to the 
library. Create a user as follows: 

1. Using the CS Explorer, create a new user in the FileNet library. Ensure the user has the following 
attributes.  

a. Add Item privileges 

b. Author privileges for all folders in the system. 

c. Member of Admin group. 

d. “May Create Document” privileges on all document classes required for email. 

2. In the Implementation Worksheet, record the new user name in the section FileNet Content 
Services under the setting Email Manager FileNet User. 

3.1.2 FileNet Image Services 
The setup required in this section assumes the administrator is knowledgeable about FileNet Image 
Services administration. 

3.1.2.1 Collect Library Information 
In the Implementation Worksheet, enter the following information in the section FileNet Image Services 
under the settings specified. 

6. Under FileNet Image Services Version, enter the version of Image Services being used. 

7. Under Panagon Web Version, enter the version of Panagon Web being used. 

8. Under Operating System, enter the name and version of the operating system Image Services 
resided on. 

9. Under Domain, enter the library domain name 

10. Under Organization, enter the name of the library organization 

3.1.2.2 Document Class/Custom Property Setup 
Document classes and custom properties required are dependent on the business requirements for email 
indexing.  Any document classes and custom properties required should be created prior to Email 
Manager setup and configuration. See the section APPENDIX B: DOCUMENT CLASS 
CONFIGURATION for suggestions for custom property configuration 

3.1.2.3 User Creation 
A user in the FileNet library needs to be created for Email Manager to use when adding email to the 
library. Create a user as follows: 

1. Ensure the user has permissions to add items to the library. 

2. In the Implementation Worksheet, record the new user name in the section FileNet Image 
Services under the setting Email Manager FileNet User. 
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3.1.3 FileNet P8 Content Engine 
The setup required in this section assumes the administrator is knowledgeable about FileNet P8 Content 
Engine administration. 

3.1.3.1 Collect Library Information 
In the Implementation Worksheet, enter the following information in the section FileNet P8 Content 
Engine under the settings specified. 

1. Under FileNet P8 Content Engine Version, enter the version of Content Engine being used. 

2. Under Operating System, enter the name and version of the operating system Content Engine 
resided on. 

3. Under Object Store, enter the object store name (library name). 

4. Under Host Server, enter the name of the server Content Engine resides on. 

3.1.3.2 Document Class/Custom Property Setup 
Document classes and custom properties required are dependent on the business requirements for email 
indexing.  Any document classes and custom properties required should be created prior to Email 
Manager setup and configuration. See the section APPENDIX B: DOCUMENT CLASS 
CONFIGURATION for suggestions for custom property configuration. Note that a document class named 
“Email” is created by default when Content Engine is installed. This document class may be utilized with 
Email Manager. 

3.1.3.3 User Creation 
A P8 Content Engine user needs to be created for Email Manager to use when adding email to Content 
Engine. To add a document to an object store and file a document into a folder, the user minimally needs 
to be a part of one of the "Initial User Groups". The group must have "use object store" permissions (this 
is the default permissions the group is granted when the object store is created).  

On the object store, the user must minimally have the following permissions: 

• Use object store 

On each document class that will be used with email manager, the user must minimally have the following 
permissions: 

• Allow: View all properties  

• Allow: Create instance  

• Allow: Read permissions 

If a file store will be used with the object store, the user must have “Full Control” over the file store share. 

In the Implementation Worksheet, record the user name in the section FileNet P8 Content Engine under 
the setting Email Manager FileNet User. 
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3.1.3.4 Records Manager Configuration 
If Records Manager will be used, permissions on Record Classes must be explicitly set. The FileNet P8 
Content Engine User must be EXPLICITLY GRANTED RIGHTS TO ANY RECORD CLASSES THAT 
WILL BE USED. Regardless of other permissions that the user may be granted in the object store (even 
P8 administrator privileges), the following instructions MUST be followed as NO USERS ARE GRANTED 
REQUIRED PRIVILEGES TO RM RECORD CLASSES BY DEFAULT: 

1. In FileNet Enterprise Manager, select the File Plan Object Store that will be used. 

2. Select the Record Class that will be used (i.e. Document Class->Record->Electronic Record-
>Email Record). 

3. Right-click, select "Properties". 

4. Open the "Default Instance Security" tab. 

5. Give the FileNet P8 Content Engine User the same privileges as the #CREATOR- OWNER 
user (usually full control). 

6. Repeat for each Record Class that will be used. 

If custom properties are being added to a record class, the word “declare” must be added to the 
property’s Description field. Each item that appears in the Description fields should be separated by a 
comma.
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3.2 Email Server Configuration 

3.2.1 Exchange Server 

3.2.1.1 Collect Exchange Server Information 
In the Implementation Worksheet, enter the following information in the section Exchange Server under 
the settings specified. 

1. Under Exchange Server Version enter the version of Exchange Server being used and the 
service pack level. 

2. Under Operating System, enter the name and version of the operating system the Exchange 
Server resides on. 

3. Under Exchange Server, enter the name of the machine the Exchange Server resides on. 

3.2.1.2 Windows Domain User Configuration 
A Windows domain user that will be used by the Exchange Connector needs to be created. Create a user 
as follows: 

1. Create a domain user that will be used to run the Exchange Connector (i.e. eMgrservice). 
Minimally, the user must be assigned the following security privileges: 

a. On the Mail Store(s) of the folders and mailboxes being monitored, the user must have 
“Administer Information Store” permissions. 

b. For any Exchange public folders that Email Manager will monitor, the user must have 
“Publishing Editor” (monitored folder) and “Contributor” permissions. 

c. “Full Control” on all folders on the machine the Exchange Connector is installed on. 
2. Record the domain user id in the Implementation Worksheet in the Windows Domain section 

under the setting Windows Domain User. Under Active Directory, enter “Yes” if active 
directory is being used or “No” if active directory is not being used. 

3. Create a mailbox on the Exchange Server for the Windows Domain User.  
4. Record the name of the mailbox in the Implementation Worksheet in the Exchange Server 

section under the setting Email Manager Exchange User. 
 
If the PST Connector will be used to search for PST Archive Files on network shares, the user will require 
the following additional permissions: 
 

1. The user must be a member of the Domain Users group. 
2. The user must have “Full Control” on any folders on the network share that will be searched for 

PST archives. This includes both user shares and default shares (i.e. C$). In addition, to 
support the option to disable PST file creation on a computer, the user must have “Full Control” 
on the folder containing the MAPI configuration file (MAPISVC.INF). The file is typically located 
in “C:\Program Files\Common Files\System\Mapi\1033”. 

3. If the option to search for PST files using the Outlook Profile is required, the user will required 
read access to “Software\Microsoft\Windows NT\CurrentVersion\Windows Messaging 
Subsystem\Profiles” for each “HKEY_CURRENT_USER” registry hive on each computer. 
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3.2.2 Lotus Domino Server 

3.2.2.1 Collect Domino Server Information 
In the Implementation Worksheet, enter the following information in the section Domino Server under the 
settings specified. 

1. Under Domino Server Version enter the version of Domino Server being used and the service 
pack level. 

2. Under Operating System, enter the name and version of the operating system the Domino 
Server resides on. 

3. Under Domino Server Name, enter the name of the Domino Server. 

4. Under Organization Name, enter the name of the Organization the Domino Server belongs to. 

5. Under Domain Name, enter the name of the Domain the Domino Server belongs to. 

3.2.2.2 Windows Domain User and Domino User Configuration 
A Windows domain user that will be used by the Lotus Connector needs to be created. Create a user as 
follows: 

1. Create a domain user that will be used to run the Lotus Connector (i.e. eMgrservice). 
Minimally, the user must be assigned the following security privileges: 

a. “Full Control” on all folders on the machine the Lotus Connector is installed on. 
b. The user must be able to access the Lotus Domino server Email Manager will connect 

to.  
2. Record the domain user id in the Implementation Worksheet in the Windows Domain section 

under the setting Windows Domain User. Under Active Directory, enter “Yes” if active 
directory is being used or “No” if active directory is not being used. 

3. Create a user on the Domino Server for the Windows Domain User. The user must minimally 
have “Editor”, “Delete Documents” and “Replicate or Copy Documents” permissions in all 
mailboxes and other databases used with Email Manager. Note that the following “Editor” 
access level permissions are NOT required: “Create private agents”, “Create personal 
folders/views”, “Create shared folders/views” and “Create LotusScript/Java agents”. 

4. Record the name of the user in the Implementation Worksheet in the Lotus Domino Server 
section under the setting Email Manager Domino User. 

 

3.2.3 GroupWise Server 
In the Implementation Worksheet, enter the following information in the section GroupWise Server under 
the settings specified. 

1. Under GroupWise Server Version enter the version of GroupWise Server being used and the 
service pack level. 

2. Under Operating System, enter the name and version of the operating system the GroupWise 
Server resides on. 

3. Under GroupWise Domain, enter the name of the GroupWise Domain that will be used. 

4. Under Domain Directory UNC Path, enter the UNC path that may be used to access the 
GroupWise Server domain directory.  
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3.2.3.1 Windows Domain User and eDirectory User Configuration 
A Windows domain user that will be used by the GroupWise Connector service needs to be created. 
Create a user as follows: 

1. Create a domain user that will be used to run the GroupWise Connector service (i.e. 
eMgrservice). Minimally, the user must be assigned the following security privileges: 

c. “Full Control” on all folders on the machine the GroupWise Connector is installed on. 
d. Read/Write access to the Domain Directory UNC Path.  

2. Record the domain user id in the Implementation Worksheet in the Windows Domain section 
under the setting Windows Domain User.  

3. Create a user in eDirectory that the GroupWise connector will use to connect to eDirectory to 
query for post offices and accounts. The user must minimally have rights to access the domain 
database (system-level administration rights)..  

4. Record the name of the user in the Implementation Worksheet in the GroupWise Server 
section under Email Manager GroupWise User. In addition, record the NDS Tree and NDS 
Context that the user belongs in. 

 

3.3 Email Manager Server Configuration 
This section describes pre-requisite activities that need to be performed on the server that the Email 
Manager server components will be installed on. 

3.3.1 Collect eMgr Server Information 
In the Implementation Worksheet, enter the following information in the section Email Manager Server 
under the settings specified. 

1. Under Operating System, enter the name and version of the operating system installed on the 
Email Manager Server. 

2. Under Email Manager Server Machine,  enter the name of the machine that will be used to the 
run the Email Manager Server 

3.3.2 Temporary Storage Folders 
Two folders must be created on Email Manager Server Machine that will be utilized as temporary storage 
space and log files by the Email Manager Server components. The following names are suggested: 

Temporary folder: C:\eMgr_temp 

Log File Folder: C:\eMgr_logs 

The folders should be created at the root level of the drive (i.e. c:\eMgr_temp) and the default IIS user on 
Email Manager Server Machine (typically IUSR_<machine_name>) as well as Windows Domain User 
should have the following permissions on the folder: 

• Modify 

• Read & Execute 

• List Folder Constraints 

Record the paths for the folders in the Implementation Worksheet in the section Email Manager Server 
under Temporary Folder and Log File Folder. 

If FileNet Content Services is being used, the default IIS User and Windows Domain User also require 
the same permissions on the following folders: 
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• The root folder of the temporary storage folder (i.e. if the temp folder is C:\eMgr_temp, 
permissions need to be assigned to C:\). 

• <drive>\Program Files\FileNet\Shared 

• <drive>\Winnt\Temp 

• <drive>\Winnt\System32 

3.3.3 Document Repository Specific Configuration 

3.3.3.1 FileNet Content Services 

3.3.3.1.1 Panagon Desktop Installation and Configuration 

Panagon Desktop or Panagon Web is required by Email Manager Server components to allow for 
communication with FileNet libraries. Install and configure Panagon Desktop/Web as follows. Note that if 
Panagon Desktop/Web has been already been installed and configured on the machine, this setup should 
not be required.  

1. Log into Email Manager Server Machine as a user who has permissions to install software on 
the machine. 

2. Install either Panagon Desktop 3.x (including Panagon Client Libraries 5.x). or Panagon Web 
Services 3.x on the machine. The server will need to be rebooted to complete the installation. 

3. Log into Email Manager Server Machine as a user who has permissions to install software on 
the machine. 

4. Using the Panagon Configure utility, configure the library(s) that will be used to store email 
using the Library System and Library Server names.  When creating the library, ensure the 
library is configured using the “Set default preferences for new users” option.  
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3.3.3.2 FileNet Image Services 

3.3.3.2.1 Panagon Web Installation and Configuration 

Panagon Web is required by Email Manager Server components to allow for communication with FileNet 
Image Services libraries. Install and configure Panagon Web as follows. Note that if Panagon Web has 
been already been installed and configured on the machine, this setup should not be required.  

5. Log into Email Manager Server Machine as a user who has permissions to install software on 
the machine. 

6. Install Panagon Web Services 3.x (including Panagon Client Libraries 5.x required to access 
the version of Images Services being used) on the machine. 

7. Using the Panagon Configure utility, configure the library(s) that will be used to store email 
using the Domain and Organization names for the IS library. When creating the library, 
ensure the library is configured using the “Set default preferences for new users” option.  

 

3.3.3.3 FileNet P8 Content Engine 

3.3.3.3.1 P8 CE Client Tools Installation and Configuration 

P8 CE client connectivity tools and the P8 COM SDK are required by Email Manager components to 
allow for communication with FileNet P8 CE object stores. Install and configure the P8 CE components as 
follows.  Note that if the P8 CE components have already been installed and configured on the machine, 
this setup should not be required.  

1. Log into Email Manager Server Machine as a user who has permissions to install software on 
the machine. 

2. Install FileNet P8 Client Connectivity and Content Engine SDK. 
3. Configure P8 to connect to the P8 Content Engine server. 

 
 

3.3.4 Email Server Specific Configuration 

3.3.4.1 Exchange Server 

3.3.4.1.1 Outlook Installation and Configuration 

The Email Manager Server requires components of Outlook to connect to the Exchange Server. Outlook 
installs CDO components required by the Exchange Connector. Outlook must be installed on the Email 
Manager Server Machine and configured for the Email Manager Exchange User. 

Install and configure Outlook on Email Manager Server Machine as follows: 

1. Log into Email Manager Server Machine as a user who has permissions to install software on 
the machine. 

2. Install Microsoft Outlook. Ensure that the custom installation is used and that Collaborative 
Data Objects is selected in the setup screen. 
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3. Log into Email Manager Server Machine as Windows Domain User. 

4. Create an Outlook Profile for Email Manager Exchange User and give it a name such as 
“Email Manager User”.  

3.3.4.1.2 Public Folder Creation 

The Email Manager Exchange Connector monitors public folders in Exchange Server for emails. Emails 
that arrive in a public folder are processed by Email Manager and added to the document library. The 
public folders that need to be created are dependent upon the requirements for the implementation.  

Public folders that are created must have the following attributes: 

• The folder should be created under Public Folders\All Public Folders 

• Email Manager Exchange User must have Owner permissions on the folder 

o If the folder is being created for use by the Email Manager Client, all users require 
Author privileges on the folder. 

o If the folder is being created for use for a rules bases system, only Email Manager 
Exchange User requires access to the folder 

The following instructions are a guideline for creating the folders. The actual folders created will depend 
upon whether rules based capture or end user capture is required. 

If the Email Manager Client will be utilized, create a public folder that will be utilized by the Email Manager 
Client as follows: 

1. Log into Email Manager Server Machine as Windows Domain User. 

2. Open Outlook using the profile Outlook Profile Name for Email Manager Exchange User 

3. Under Public Folders\All Public Folders create a new public folder. Give the public 
folder a name such as “Email Manager Client”. The public folder may be created as a subfolder of 
another folder. Record the public folder name (prefixed by the names of any “parent” folders, not 
including Public Folders\All Public Folders) in the Implementation Worksheet in the section 
Exchange Server under Public Folder for Email Manager Client.  

4. Grant the folder the following permissions:  

a. Ensure Email Manager Exchange User has been given “Owner” permissions by default. 

b. Minimally, give all other users “Contributor” access to the folder.  

If email will be added to the document library based on a rules based system, create a public folder as 
follows: 

1. Log into Email Manager Server Machine as Windows Domain User. 

2. Open Outlook using the profile Outlook Profile Name for Email Manager Exchange User 
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3. Under Public Folders\All Public Folders create a new public folder. Give the public 
folder a name such as “Email Manager Rules”. The public folder may be created as a subfolder of 
another folder. Record the public folder name (prefixed by the names of any “parent” folders, not 
including Public Folders\All Public Folders) in the Implementation Worksheet in the section 
Exchange Server under Public Folder(s) for Email Manager Rules. 

4. Grant the folder the following permissions:  

a. Ensure Email Manager Exchange User has been given “Owner” permissions by default. 

b. If this folder is being used as the Message Journaling folder (see below), no other user’s 
require access to the folder.  

c. If user’s will be dragging and dropping email into the folder, “Contributor” access must be 
granted to required users and groups. Optionally, the “Folder Visible” option may be de-
selected to prevent users from seeing the contents of the folder. 

Email Manager may be configured to monitor all sub-folder of a public folder. All sub-folders should be 
granted the same permissions as the parent folder. 

Note that it may be necessary to enable Message Journaling on the Exchange Server to take full 
advantage of a rules based system. See the section APPENDIX C: EMAIL SERVER MESSAGE 
JOURNALING CONFIGURATION for details on enabling Message Journaling. 

To verify that the public folders have been configured correctly, do the following: 

1. Log into Email Manager Server Machine as Windows Domain User. 

2. Ensure the Email Manager services are not running. 

3. Open Outlook. 

4. Drag and drop email messages from the Inbox into Public Folder for Email Manager Client as 
well as Public Folder(s) for Email Manager Rules. If errors occur, folder permissions may be 
incorrect. 

5. Navigate to Public Folder for Email Manager Client and view the contents of the folder. The 
email message dragged from the Inbox should appear in the folder. If it does not, the folder 
permissions may be incorrect. 

6. Attempt to delete the email message in Public Folder for Email Manager Client. If the email 
cannot be deleted, the folder permissions may be incorrect. 

7. Repeat steps 3 to 5 for Public Folder(s) for Email Manager Rules. 

8. Login into a client workstation as an end user. The workstation should have Outlook installed on it 
and configured to access the Exchange Server. 

9. Open Outlook. 

10. Drag and drop email messages from the Inbox into Public Folder for Email Manager Client as 
well as Public Folder(s) for Email Manager Rules. If errors occur, folder permissions may be 
incorrect. 

11. Drag and drop email messages that have attachments from the Inbox into Public Folder for 
Email Manager Client as well as Public Folder(s) for Email Manager Rules (if drag and drop 
capture is being implemented). If errors occur, folder permissions may be incorrect. 

Note: This test is only to be used for verifying whether public folder permissions have been configured 
correctly. The procedures described above should not be used when the Email Manager services are 
running as system errors may occur. 
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3.3.4.2 Lotus Domino 

3.3.4.2.1 Lotus Notes Installation and Configuration 

The Email Manager Server requires components installed by Lotus Notes to connect to the Domino 
Server. Lotus Notes must be installed on the Email Manager Server Machine and configured for the 
Email Manager Domino User. 

Install and configure Lotus Notes on Email Manager Server Machine as follows: 

1. Log into Email Manager Server Machine as a user who has permissions to install software on 
the machine. 

2. Install Lotus Notes.  

3. The Lotus Notes API required by Email Manager is not registered by default and must be 
manually registered as follows: 

a. Open a command prompt window. 

b. Change the folder the folder Lotus Notes is installed in (by default it will be 
<drive>:\Program Files\lotus\notes) 

c. Register the DLL nlsxbe.dll: 

regsvr32 nlsxbe.dll 

4. Log into Email Manager Server Machine as Windows Domain User. 

5. Configure Lotus Notes to connect to the Domino server as Email Manager Domino User.  

6. Create a temporary “cache” database on the local machine for the Lotus Connector to use. The 
cache database is used as temporary workspace when creating shortcut links, removing 
attachments and truncating messages.  It also stores temporary diagnostic information and 
information on items that cause errors during processing. The database may be used when 
troubleshooting issues with the Lotus Connector. See APPENDIX I: Lotus Connector Cache 
Database Codes for a list of status codes that are written to the database. Create the database 
as follows: 

a. From the Lotus Notes menu choose "File-Database-New..." The New Database dialog 
will show. Enter the following values: 

b. In the “Specify New Database Name and Location” section, enter the following 
information: 

i. In the Server combo-box, choose the server “Local”  

ii. In the Title textbox, enter “Cache”. 

iii. In the File name textbox, enter eMgr\cache.nsf.  

c. In the “Specify Template for New Database” section, enter the following information: 

i. In the Server combo-box, choose the server “Local” 

ii. In the Template list, select the template “Blank”4. 

d. The Email Manager Domino User should be have “Editor”, “Delete Documents” and 
“Replicate or Copy Documents'” access to the database eMgr\cache.nsf 

e. Click "OK". 
                                                      
4 A Cache Database template is included in the eMgr installation package and may be utilized as the 
template for the cache.nsf database. Use of the template is optional but highly recommended to assist 
with system troubleshooting. See APPENDIX E: Email Manager Lotus Notes Templates for details. 
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In the situation where a high volume of email will be processed, creating the “cache” database on the 
Domino Server may help improve performance. If the “cache” database is located somewhere other than 
the default location specified above, update in the Cache Server and Cache Database Path in Email 
Manager Configuration Manager (in the Advanced Options in the Lotus Connector Configuration 
screen).If multiple Email Manager servers will be used, each server should have it’s own cache database 
to avoid potential conflicts. 

3.3.4.2.2 Database Creation 

The Email Manager Lotus Connector monitors databases in Domino Server for emails. Emails that arrive 
in a database are processed by Email Manager and added to the document library. The databases that 
need to be created are dependent upon the requirements for the implementation.  

Databases that are created for use by Email Manager should have the following attributes: 

• Email Manager Domino User must have “Editor”, “Delete Documents” and “Replicate or Copy 
Documents” permissions on the database 

o If the database is being created for use by the Email Manager Client, all users who will 
be using the client require ”Depositor” permissions on the database. This could be 
implemented by creating an “Email Manager” group in Domino, assigning “Depository” 
permissions to the group and adding all required users to the group. 

o If Email Manager will be required to monitor mailboxes or perform any processing 
options in mailboxes (i.e. icon change or create shortcuts), “Editor” permissions must 
be granted to the Email Manager Domino User for each mailbox. In addition, if Email 
Manager Domino User will be required to delete items from mailboxes, “Delete 
Documents” and “Replicate or Copy Documents” permissions are required. 

o If the database is being created for use for a rules based system, only Email Manager 
Domino User requires access to the database  

The following instructions are a guideline for creating the databases. The actual databases created will 
depend upon whether rules based capture or end user capture is required. 

If the Email Manager Client will be utilized, create a database that will be utilized by the Email Manager 
Client as follows: 

1. Log into Email Manager Server Machine as Windows Domain User. 

2. Open Lotus Notes and login as Email Manager Domino User 

3. From the Lotus Notes menu choose "File-Database-New..." 

4. The New Database dialog will show. Enter the following values: 

5. In the “Specify New Database Name and Location” section, enter the following information: 

a. In the Server combo-box, choose the Domino server. 

b. In the Title textbox, enter a name for the database (i.e “Email Manager Client Database”) 

c. In the File name textbox, enter a filename for the database (i.e. eMgr\eMgrclient.nsf). 
Record the filename in the Implementation Worksheet in the section Domino Server 
under Database for Email Manager Client.  

6. In the “Specify Template for New Database” section, enter the following information: 

a. In the Server combo-box, choose the Domino server 
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b. In the Template list, select the template “Blank”5. 

7. Click "OK". 

8. Grant the following permissions for the database:  

a. Ensure Email Manager Domino User has been given “Editor”, “Delete Documents” and 
“Replicate or Copy Documents” permissions. 

b. All users who will be using the client require ”Depositor” permissions on the database.  

If email will be added to the document library based on a rules based system, create a database as 
follows: 

1. Log into Email Manager Server Machine as Windows Domain User. 

2. Open Lotus Notes and login as Email Manager Domino User 

3. From the Lotus Notes menu choose "File-Database-New..." 

4. The New Database dialog will show. Enter the following values: 

a. In the “Specify New Database Name and Location” section, enter the following 
information: 

i. In the Server combo-box, choose the Domino server. 

ii. In the Title textbox, enter name for the database (i.e “Email Manager Capture 
Database”). 

iii. In the File name textbox, enter a filename for the database (i.e. 
eMgr\eMgrcap.nsf). Record the filename in the Implementation Worksheet in the 
section Domino Server under Database for Rules.  

b. In the “Specify Template for New Database” section, enter the following information: 

i. In the Server combo-box, choose the Domino Server. 

ii. In the Template list, select the template “Mail (R6)” or “Mail (R5)6. 

c. Click "OK". 

c. Grant the following permissions for the database:  

1. Ensure Email Manager Domino User has been given “Editor”, “Delete 
Documents” and “Replicate or Copy Documents” permissions. 

5. Make the database a “mail-in” database as follows: 

a. In the Start Menu, select Programs -> Lotus Applications -> Lotus Domino Administrator. 

b. Select the Domain tab. 

c. Select the People and Groups Tab. 

d. Navigate the tree “Domino Directories, <Domain> Address Book, Mail-in 
Databases_Resources” 

e. Click on the “Add Mail-In Database” button. 

f. In the Mail-In Database screen Basics tab, enter the following information: 

                                                      
5 An eMgr Client database template is included in the eMgr installation package and may be utilized as 
the template for the client database. Use of the template is optional. 
6 An eMgr rules capture database template is included in the eMgr installation package and may be 
utilized as the template for the client database. Use of the template is optional. 
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i. Mail-in name: <enter a name>. 

ii. Description <enter a description> 

iii. Internet Address: <enter an internet address for the location> 

iv. Domain: <enter the domain the database resides in> 

v. Server: <enter the name of the server the database resides on> 

vi. Filename:  <enter the filename for Database for Rules>. 

g. Click on the Save and Close button. 

Note that it may be necessary to enable Message Journaling on the Domino Server to take full advantage 
of a rules based system. See the section APPENDIX C: EMAIL SERVER MESSAGE JOURNALING 
CONFIGURATION for details on enabling Message Journaling. 

3.3.4.3 GroupWise 

3.3.4.3.1 GroupWise Client Installation and Configuration 

The Email Manager Server requires components installed by the GroupWise Client to connect to the 
GroupWise Server. GroupWise Client must be installed on the Email Manager Server Machine and 
configured for the Email Manager GroupWise User. 

Install and configure the GroupWise Client on Email Manager Server Machine as follows: 

1. Log into Email Manager Server Machine as a user who has permissions to install software on 
the machine. 

2. Install the GroupWise Client.  

3. Log into Email Manager Server Machine as Windows Domain User. 

4. Configure the GroupWise Client to connect to the GroupWise server as Email Manager 
GroupWise User.  

3.3.4.3.2 GroupWise Post Office and Account Configuration 

The Email Manager GroupWise Connector monitors Accounts in GroupWise for emails. Emails contained 
in Accounts are processed by Email Manager and added to the document library. The Accounts that need 
to be created are dependent upon the requirements for the implementation.  

Accounts that are created must have the following attributes: 

• Email Manager Groupwise User must have access to the account. 

• If the Account is being created for use by the Email Manager Client, both users and the Email 
Manager GroupWise User must be able to send email to the account. 

• If the Account is being created for use in a rules based system, only Email Manager GroupWise 
User requires access to the account. 

The following instructions are a guideline for creating the Accounts. The actual Accounts created will 
depend upon whether rules based capture or end user capture is required. 

If the Email Manager Client will be utilized, create an Account in the GroupWise Domain that will be 
utilized by the Email Manager Client. 

If email will be added to the document library based on rules, determine what Accounts or Post Offices 
that Email Manager should process email in. For each Account of Post Office, ensure Email Manager 
GroupWise User has been given permissions to access the accounts. 
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3.3.5 .Net Configuration 
Ensure that Internet Information Server is installed on the machine. If it is not, it must be installed on the 
Email Manager Server Machine prior to .Net Framework installation. Also, if FileNet Content Services or 
Image Services is being used .Net should be installed after configuring Panagon Desktop/Web. If it is not, 
the default .Net user (ASPNET) may not be able to access the FileNet library information. If this is the 
case, the user that .Net is using may need to be changed to a domain user for whom the required 
Panagon Libraries have been configured on the machine. See APPENDIX F: CHANGING .NET USER for 
details how to change the default user for .Net. 

Install .Net framework as follows: 

1. Log into Email Manager Server Machine as a user who has permissions to install software on 
the machine. 

2. Install Microsoft .Net Framework 1.1 (.Net Framework may be obtained from 
http://windowsupdate.microsoft.com). 

3. If using P8 Content Engine, update the .Net user to be the Windows Domain User. See 
APPENDIX F: CHANGING .NET USER for details how to change the default user for .Net. This is 
required to allow the Email Manager Web Services to connect to P8 Content Engine Object 
Stores. 

 

3.3.6 Oracle Client Configuration 
If Oracle is being used as the database for Email Manager, Oracle Client tools must be installed on the 
Email Manager Server Machine. In addition, the Oracle Client must be configured to allow the Oracle 
Client to connect to the Oracle database. In the Implementation Worksheet, in the section Oracle Server, 
in the field Host String, record the name of the host string that should be used to connect to the Oracle 
Server. 
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3.4 Database Configuration 
This section describes the configuration required on the database server to support Email Manager. 

3.4.1 SQL Server Configuration 
The setup required in this section assumes the administrator is knowledgeable about SQL Server 
administration. Note that SQL Server must be installed in “mixed mode” for use by Email Manager. 

3.4.1.1 Collect SQL Server Information 
In the Implementation Worksheet, enter the following information in the section SQL Server under the 
settings specified. 

1. Under Operating System, enter the name and version of the operating system the SQL Server 
resided on. 

2. Under SQL Server Name, enter the name of the SQL Server. 

3. Under SQL Server IP, record the IP address of the SQL Server. 

3.4.1.2 SQL Server Database and User 
Email Manager uses Microsoft SQL Server to store various configuration settings and data.  

The following SQL Server configuration is required on the SQL Server that will be used by Email 
Manager: 

1. Create a new database for Email Manager to use. Record the name of the database in the 
Implementation Worksheet in the section SQL Server under Database. 

2. Create a user for Email Manager to use to connect to the database. Record the user name in the 
Implementation Worksheet in the section SQL Server under Email Manager SQL User. 

a. Set the user’s default database to Database. 

b. Grant the user read and write privileges (db_datareader and db_datawriter) in Database. 

 

3.4.2 Oracle Configuration 
The setup required in this section assumes the administrator is knowledgeable about Oracle 
administration. 

3.4.2.1 Collect Oracle Information 
In the Implementation Worksheet, enter the following information in the section Oracle Server under the 
settings specified. 

1. Under Operating System, enter the name and version of the operating system the SQL Server 
resided on. 

2. Under Host, enter the name of the Oracle host. 

3. Under Port, enter the port used by Oracle. 

4. Under SID, enter the SID of the Oracle database. 
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3.4.2.2 Oracle Database and User 
Email Manager uses Oracle to store various configuration settings and data.  

The following Oracle configuration is required on the Oracle database that will be used by Email 
Manager: 

1. Create a user for Email Manager to use to connect to the database. Record the user name in the 
Implementation Worksheet in the section Oracle Server under Email Manager Oracle User. 

a. Grant the user read, write and table creation privileges in Database. 

b. Create a Tablespace for the user in which Email Manager database objects may be 
created. 

A script is also included with Email Manager that may be executed by an Oracle DBA to facilitate creation 
of the user (in lieu of manually creating the user). The script, named fn_emm_ora_setupusr.sql, can 
be found on the Email Manager distribution media in the folder Database Scripts\Custom Oracle. 
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4 INSTALLATION 

4.1 Database Setup 
This section describes the installation of Email Manager database components. 

4.1.1 SQL Server 
After the database has been created, the database objects required by Email Manager must be created. 
To setup the Email Manager Database, do the following: 

1. Open SQL Server Query Analyzer and connect to the Database as an administrative user. 

2. Depending on the email server and document repository being used, run the appropriate scripts 
to create the database objects required by Email Manager. Ensure that scripts are run in the 
Database created specifically for Email Manager.  The scripts can be found in the Database 
Scripts folder on the distribution media (see the table below for the exact location of the 
required scripts). 

a. Run the required database script. 

The database scripts required for the email server and repository being used can be found in the 
Database Scripts folder in the Email Manager distribution package. Refer to the table below to determine 
which database script is required. 

 

Email Server Repository File Name 

Exchange Server FileNet Content Services db_sql_exch_cs.sql 

Exchange Server FileNet P8 Content Engine db_sql_exch_p8.sql 

Exchange Server FileNet Image Services db_sql_exch_is.sql 

Lotus Notes FileNet Content Services db_sql_lotus_cs.sql 

Lotus Notes FileNet P8 Content Engine db_sql_lotus_p8.sql 

Lotus Notes FileNet Image Services db_sql_lotus_is.sql  

GroupWise FileNet Content Services db_sql_gw_cs.sql 

GroupWise FileNet P8 Content Engine db_sql_gw_p8.sql 

GroupWise FileNet Image Services db_sql_gw_is.sql 

 

If Email Manager is being installed for use with a Content Services system that has been upgraded from 
Content Services 4.x, it will be necessary to create an additional database record to specify what Content 
Services custom property refers to the document class. Please contact Email Manager support for details 
on creating this record. 
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4.1.2 Oracle 
After the database has been created, the database objects required by Email Manager must be created. 
For user’s who desire greater control over the creation of the database objects, see the section Custom 
Oracle Scripts below. 

To setup the Email Manager Database, do the following: 

3. Open Oracle SQL *Plus and connect to the Database as Email Manager Oracle User. 

4. Depending on the email server and document repository being used, run the appropriate scripts 
to create the database objects required by Email Manager. The scripts can be found in the 
Database Scripts folder on the distribution media (see the table below for the exact location 
of the required scripts). 

a. Run the required database script. 

The database scripts required for the email server and repository being used can be found in the 
Database Scripts folder in the Email Manager distribution package. Refer to the table below to determine 
which database script is required. 

 

Email Server Repository File Name 

Exchange Server FileNet Content Services db_ora_exch_cs.sql 

Exchange Server FileNet P8 Content Engine db_ora_exch_p8.sql 

Exchange Server FileNet Image Services db_ora_exch_is.sql 

Lotus Notes FileNet Content Services db_ora_lotus_cs.sql 

Lotus Notes FileNet P8 Content Engine db_ora_lotus_p8.sql 

Lotus Notes FileNet Image Services db_ora_lotus_is.sql  

Exchange Server FileNet Content Services db_ora_gw_cs.sql 

Exchange Server FileNet P8 Content Engine db_ora_gw_p8.sql 

Exchange Server FileNet Image Services db_ora_gw_is.sql 

 

If Email Manager is being installed for use with a Content Services system that has been upgraded from 
Content Services 4.x, it will be necessary to create an additional database record to specify what Content 
Services custom property refers to the document class. Please contact Email Manager support for details 
on creating this record. 
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4.1.2.1 Custom Oracle Scripts 
A set of database scripts have been provided that may be customized by Oracle DBA’s. The scripts can 
be found on the Email Manager distribute media in the folder Database Scripts\Custom Oracle. 
See the scripts for further instructions. The following is a summary of the scripts that are available: 

File Name Purpose 

fn_emm_ora_setupusr.sql Script to create a user in the database for Email Manager to use. This 
script must be run prior to running the other scripts. 

fn_emm_ora_exch_cs.sql Exchange/Content Services version of script to create database 
objects. 

fn_emm_ora_exch_is.sql Exchange/Image Services version of script to create database objects. 

fn_emm_ora_exch_p8.sql Exchange/P8 version of script to create database objects. 

fn_emm_ora_gw_cs.sql GroupWise/Content Services version of script to create database 
objects. 

fn_emm_ora_gw_is.sql GroupWise /Image Services version of script to create database 
objects. 

fn_emm_ora_gw_p8.sql GroupWise /P8 version of script to create database objects. 

fn_emm_ora_lotus_cs.sql Lotus/Content Services version of script to create database objects. 

fn_emm_ora_lotus_is.sql Lotus/Image Services version of script to create database objects. 

fn_emm_ora_lotus_p8.sql Lotus/P8 version of script to create database objects. 

 

4.2 Install Required Components 
Install the required Email Manager components as follows: 

1. Log into Email Manager Server Machine as a user who has permissions to install software on 
the machine. 

2. Run the file setup.exe located in the eMgr Server folder on the Email Manager distribution 
media. 

3. In the Welcome screen click Next. 

4. In the License Agreement screen, if you agree with terms in the license, select the “I accept the 
term in the license agreement” radio button and click Next. 

5. In the Customer Information screen, update customer information as required. Click Next. 

6. In the Server Options screen, select the Source Server Type, FileNet Repository Type and 
Database Type being used. 

7. In the Setup Type screen, select Complete if typical settings are required or Custom if any items 
need to be removed or added to the installation and click Next. 

8. If Custom was selected as the Setup Type, in the Custom Setup screen, select the components 
to install. Click Next to continue. 

9. Click Finish to begin the installation. 
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Note if performing a “custom” installation, if the default installation path is changed, do not use a “(“ 
character in the installation path. This may cause problems when using Oracle with Email Manager. 

If FileNet Records Manager will be utilized with Email Manager, the following additional 
configuration is required: 
 

1. From the application server Records Manager is installed on, copy the folder WEB-INF to a 
location on the Email Manager Server Machine. This folder contains the RM Java API and 
configuration settings for the RM installation. Ensure you copy the folder from the deployed 
location (for example: C:\jboss-4.0.2\server\default\deploy\RecordsManager.war\ or C:\Program 
Files\Apache Group\Tomcat 5.0\webapps\RecordsManager\). If Records Manager is installed on 
a UNIX machine, ensure the files are copied as binary, and edit any text files (i.e 
WcmApiConfig.properties) by replacing special UNIX characters with their corresponding 
Windows characters (i.e carriage returns). 

2. If Symmetric Encryption has been enabled between Records Manager and the CE, an additional 
2 files must be copied from the Records Manager machine.  Locate CryptoKeyFile.properties 
and UTCryptoKeyFile.properties on the Records Manager machine and copy them to the WEB-
INF folder on the Email Manager machine.  These files are usually located on the RM machine 
at <FileNet install location>\FileNet\Authentication\.  Modify the WcmApiConfig.properties file in 
the WEB-INF folder on the Email Manager machine to point to the new location of these files 
(CryptoKeyFile =C:\\Program Files\\FileNet\\Email Manager Server 3.6\\WEB-
INF\\CryptoKeyFile.properties and CryptoKeyFile/UserToken =C:\\Program Files\\FileNet\\Email 
Manager Server 3.6\\WEB-INF\\UTCryptoKeyFile.properties assuming you copied the WEB-INF 
folder to the Email Manager install directory). 

3. On the Email Manager Server Machine, install Java Platform Standard Edition 1.4.2 (available 
from java.sun.com). 

4. On the Email Manager Server Machine, open regedit and set the following registry key to the 
location of the RM Java API on the local machine.  Do this as follows: 

i. Browse to the registry key: 
 
HKEY_LOCAL_MACHINE\SOFTWARE\FileNET\eMgr\3.7\Settings\RMWrapper 
 

ii. Set the value RMPATH to the full path of the RM Java API. The RM Java API is located in 
a sub folder of WEB-INF called lib. If the WEB-INF folder was copied to C:\Program 
Files\FileNet\Email Manager Server 3.7\WEB-INF, set the registry key to: 
C:\Program Files\FileNet\Email Manager Server 3.7\WEB-INF \lib.  

4. The FileNet P8 Content Engine User must be EXPLICITLY GRANTED RIGHTS TO ANY 
RECORD CLASSES THAT WILL BE USED. Regardless of other permissions that the user 
may be granted in the object store (even P8 administrator privileges), the following instructions 
MUST be followed as NO USERS ARE GRANTED REQUIRED PRIVILEGES TO RM 
RECORD CLASSES BY DEFAULT: 

i. In FileNet Enterprise Manager, select the File Plan Object Store that will be used. 
ii. Select the Record Class that will be used (i.e. Document Class->Record->Electronic 

Record->Email Record). 
iii. Right-click, select "Properties". 
iv. Open the "Default Instance Security" tab. 
v. Give the FileNet P8 Content Engine User the same privileges as the #CREATOR- 

OWNER user (usually full control). 
vi. Repeat for each Record Class that will be used. 
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4.3 Email Manager Server Setup 

4.3.1 Configuration 
Before using the Email Manager Server, the application must be registered and configured using the 
Email Manager Configuration Manager. The following is a brief overview of the settings that need to be 
configured in the Email Manager Configuration Manager. For a more detailed explanation on how to use 
the Email Manager Configuration Manager see the Email Manager Configuration Manager User Guide. 

1. Login to Email Manager Server Machine as Windows Domain User.  

2. If installing Email Manager for GroupWise, login into Novell as Email Manager GroupWise User. 

3. Open the Email Manager Configuration Manager (select eMgr Configuration Manager in the 
menu Start -> Programs -> FileNet Email Manager 3.7 -> Server). 

4. If the Email Manager Configuration Manager is being run for the first time, a prompt asking for 
database connection information will show. 

a. In the Database Type combo box, select the database server being used (either 
Microsoft SQL Server or Oracle). 

b. For SQL Server, enter the following information:  

i. In Server, enter SQL Server Name. 

ii. In the User Name field enter Email Manager SQL User name.  

iii. In Password, enter the password for Email Manager SQL User. 

iv. Click the button Refresh to retrieve a list of databases. 

v. Select Database from the database list. 

c. For Oracle, enter the following information: 

i. In Services, enter Host String. 

ii. In the User Name field enter Email Manager Oracle User name.  

iii. In Password, enter the password for Email Manager Oracle User. 

d. Click Ok to continue. The Email Manager Configuration Manager application will open. 

5. Right click on Rules in the tree and select New Rule to create a new Rule. Create any rules 
required. 

6. In the Repositories and Index Templates section, right click on the repository type of the 
repository being used, and select New Repository to register a repository for use with Email 
Manager. 

a. In the New Repository Connection screen, select a repository from the Repository list 
box. 

b. In the User field, enter the value of Email Manager FileNet User. 

c. In the Password and Confirm Password fields, enter the password for Email Manager 
FileNet User. 

d. If shortcut functionality will be used, in the URL field, update the <server_name> in the 
URL to match the name of the server Workplace or Panagon Web Services reside on. 

e. Click Ok to save the Repository Connection settings. 
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7. In the Repositories and Index Templates section, below the repository registered for use with 
Email Manager, right click on Index Template and select New Index Template to add a new Index 
Template. Index Templates are used to specify how an item will be classified in the repository. 

8. In the Source Servers and Profiles section, right click on the email server type being used and 
select Edit to update general configuration setting related to the email server type. See the 
Configuration Manager User Guide for further details on this section. 

9. In the Source Servers and Profiles section, right click on the email server type being used and 
select New Source Server to register an email server for use with Email Manager. 

a. For Exchange Server, in the Exchange Server Name field, enter Exchange Server (in 
the Worksheet in the Exchange Server section). If the Email Manager Client will be 
used, in the Public Folder for Client field, enter the Public Folder for Email Manager 
Client (in the Worksheet in the Exchange Server section). Click Ok 

b. For Lotus Domino, in the Domino Server Name field, enter Domino Server Name (in the 
Worksheet in the Lotus Domino Server section). If the Email Manager Client will be 
used, in the Database for Client field, enter the path of the Database for Email Manager 
Client (in the Worksheet in the Lotus Domino Server section). Click Ok 

c. For GroupWise, in the Domain field, enter GroupWise Domain (in the Worksheet in the 
GroupWise Server section). In the Domain Directory field, enter Domain Directory UNC 
Path (the Windows user that is currently being used to run the Configuration Manager as 
well as the current Novell user must have access to the domain directory share). If the 
Email Manager Client will be used, in the Client Account field, enter Account for Email 
Manager Client. In the Username field, enter Email Manager GroupWise User. In the 
Password field, enter the password for the user. Click the Generate Key button to create 
a Trusted Application Key on the GroupWise Server. See APPENDIX J: GROUPWISE 
TRUSTED APPLICATION AND RETENTION CONFIGURATION for details on enabling 
the trusted application and retention in GroupWise. 

10. In the Source Servers and Profiles section, below the email server registered for use with Email 
Manager, right click on Profiles and select New Profile to add a new Profile. The Profile is used to 
specify what location on the email server will be monitored, what rules will be applied  to 
determine what items to capture, and what index template should be used to index an item. 

4.3.2 Starting the Services 
Once the Email Manager Server has been configured, the Email Manager related services can be started. 
Do the following to start the services: 

1. Go to Start -> Settings -> Control Panel -> Administrative Tool -> Services. 

2. If Email Manager for Exchange has been installed, do the following: 

a. Open the properties screen for the Service “eMgr Exchange Connector”. 

b. Go to the “Log On” tab. 

c. Click on the “This account:” radio button, and enter Windows Domain User as the 
Logon User.  Also fill in the password for this account. 

d. If the service is to be started automatically when the machine is restarted, select 
“Automatic” in the “Startup Type” drop down box.7 

e. Click OK. 
                                                      
7 If the services only need to be enabled during specific times, the Windows “net start” command may be 
used in conjunction with Windows Scheduler to schedule start times for the services. 
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3. If Email Manager for Lotus Domino has been installed, do the following: 

a. Open the properties screen for the Service “eMgr Lotus Connector”. 

b. Go to the “Log On” tab. 

c. Click on the “This account:” radio button, and enter Windows Domain User as the 
Logon User.  Also fill in the password for this account. 

d. If the service is to be started automatically when the machine is restarted, select 
“Automatic” in the “Startup Type” drop down box.8 

e. Click OK. 

4. If Email Manager for PST capture has been installed, do the following: 

a. Open the properties screen for the Service “eMgr PST Connector”. 

b. Go to the “Log On” tab. 

c. Click on the “This account:” radio button, and enter Windows Domain User as the 
Logon User.  Also fill in the password for this account. 

d. If the service is to be started automatically when the machine is restarted, select 
“Automatic” in the “Startup Type” drop down box.9 

e. Click OK. 

5. For Content Services and Image Services installations, in most cases the service “Email Manager 
Universal File Importer” will function correctly when using the default “Local System” user for the 
service. For P8 CE installation, the service must be updated to run as a domain user who is on 
the same domain as the P8 CE server. To change the service user, do the following: 

a. Open the properties for the Service “YTG Universal File Importer”. 

b. Go to the “Log On” tab. 

c. Click on the “This account:” radio button, and enter Windows Domain User as the 
Logon User.  Also fill in the password for this account. 

d. If the service is to be started automatically when the machine is restarted, select 
“Automatic” in the “Startup Type” drop down box. 

e. Click OK. 

6. Start the services (either Email Manager Exchange Connector or Email Manager Lotus 
Connector, and Email Manager Universal File Importer).  

7. To verify that the services started properly, check the log files in the log files folders specified in 
the Email Manager Configuration Manager. The following files should be checked: 

a. If Email Manager for Exchange has been installed, check the Exchange Connector log 
file for messages. The name of the log file is exchconn<date>.log. 

b. If Email Manager for Lotus Domino has been installed, check the Lotus Connector log file 
for messages. The name of the log file is lotusconn<date>.log. 

c. If Email Manager for PST capture has been installed, check the PST Connector log file 
for messages. The name of the log file is pstsconn<date>.log. 

d. Check the UFI log file for messages. The name of the log file is 
UFICoreService<date>.log where <date> is today’s date. 

 
                                                      
8 If the services only need to be enabled during specific times, the Windows “net start” command may be 
used in conjunction with Windows Scheduler to schedule start times for the services. 
9 If the services only need to be enabled during specific times, the Windows “net start” command may be 
used in conjunction with Windows Scheduler to schedule start times for the services. 
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If Email Manager for Exchange has been installed, if the capture indicator is required in Exchange (if an 
email is added to FileNet, the normal envelope icon will be changed to a FileNet icon), see the section 
APPENDIX D: EXCHANGE NOTIFICATION INDICATOR SETUP for details. 

If Email Manager for Lotus has been installed, see the section APPENDIX E: Email Manager LOTUS 
NOTES TEMPLATES for details on updating mail templates to support advanced icon change 
functionality. 

4.3.3 Email Manager Web Services 
If the Email Manager Web Services have been installed, verification steps should be performed to ensure 
the system has been configured correctly. To perform the verification, log on to the machine that the 
Email Manager Web Services have installed on and do the following repository specific tests. 

4.3.3.1 Email Manager Web Services for FileNet Content Services and Image 
Services 

 
To verify that the web services have been configured properly, do the following: 
 

1. Select CS Web Service in the menu Start -> Programs -> FileNet Email Manager  3.7 -> Server 

2. Internet Explorer will open and if the test is successful, a page labeled eCWWSCS Web Service 
will be displayed.  

3. Click the link GetLibraries. 

4. On the subsequent page, click the button labeled Invoke. 

5. A new Internet Explorer Window should open and an XML stream should show in window. The 
XML should contain a tag called Libraries and within the tag the FileNet CS libraries 
configured for use on the machine should be displayed. If the libraries are not listed, this may be 
due to either incorrect FileNet library configuration or the .Net user may not be able to access the 
library information on the machine. If the latter is true, the default .Net user may need to be 
changed. See Appendix F: Changing .Net User for details on changing the default .Net user. 

4.3.3.2 Email Manager Web Services for FileNet P8 Content Engine 
To verify that the web services have been configured properly, do the following: 
 

1. Select P8 Web Service in the menu Start -> Programs -> FileNet Email Manager  3.7 -> Server 

2. Internet Explorer will open and if the test is successful, a page labeled eCWWSP8 Web Service 
will be displayed.  

3. Click the link GetLibraries. 

4. On the subsequent page, click the button labeled Invoke. 

A new Internet Explorer Window should open and an XML stream should show in window. The XML 
should contain a tag called Libraries and within the tag the object stores configured for use on the 
machine should be displayed. If the object stores are not listed, this may be due to the .Net user being 
able to access the domain. In this case, the default .Net user may need to be changed. See APPENDIX 
F: CHANGING .NET USER for details on changing the default .Net user. 
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4.3.4 Email Manager Server Silent Install 
The Email Manager server may be “silently” installed by msiexec.exe (Microsoft Installer) with specific 
command line parameters. 

Parameter Description 

ADDLOCAL May be used to specify a comma separate list of components that should be 
included in the installation. The following is a list of component names. Note 
that the names are case sensitive. 

"ConfigUtlis"  = Configuration Manager 
"sql"  = SQL DB Connector 
"oracle" = Oracle DB Connector 
"exchangeconnector" = Exchange Connector 
"LotusConnector" = Lotus Connector 
“pstconnector" = PST Connector 
"p8connector" = P8 Repository Connector 
"isconnector"  = IS Repository Connector 
"csconnector" = CS Repository Connector  
"filerepo" = File System Repository 
"UFIService" = Universal File Importer Service 
"P8" = P8 Client Web Services 
"CS" = CS Client Web Services 
"GroupWiseConnector" = GroupWise connector service 
"ExchangeConnector1" = 2nd instance of exchange connector 
"PSTConnector1" = 2nd instance of PST connector 
"LotusConnector1" = 2nd instance of Lotus Connector 
"SymbolFiles" = debug symbol files for all items 

Example: 

msiexec /i "FileNet Email Manager Server 3.7.msi" 
ADDLOCAL=P8,sql,ConfigUtils,exchangeconnector,p8connecto
r,UFIService /q 

/q This parameter may be specified for msiexec (the Windows Installer 
application) if an install without user intervention is required. If this mode is 
being used, if values other than the defaults are required for the parameters, 
those values must be specified. 

Example: 

msiexec /i "FileNet Email Manager Server 3.7.msi" 
ADDLOCAL=P8,sql,ConfigUtils,exchangeconnector,p8connecto
r,UFIService /q 
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5 EMAIL MANAGER CLIENT 
The setup required in this section assumes the administrator is knowledgeable about Windows desktop 
administration and Exchange/Outlook or Lotus Notes administration. 

5.1 Pre-requisite Configuration 

5.1.1 Collect Client Information 
In the Implementation Worksheet, enter the following information in the section Email Manager Client 
under the settings specified. 

1. Under Operating System, enter the name and version of the operating system of the machine 
the Email Manager Client will be installed on. 

5.1.2 Desktop Software 

5.1.2.1 Email Manager Client for Exchange 
The machines running the Email Manager Client will require Outlook to be installed and configured to 
allow end users to access Exchange Server. 

5.1.2.2 Email Manager Client for Lotus Notes 
The machines running the Email Manager Client will require Lotus Notes Client to be installed and 
configured to allow end users to access Lotus Notes Server. 

5.1.2.3 Email Manager Client for GroupWise 
The machines running the Email Manager Client will require the GroupWise Client to be installed and 
configured to allow end users to access GroupWise Domain. 

5.2 Installation 
Before installing the Email Manager Client, ensure that the email client being used (either Outlook,  Lotus 
Notes, or GroupWise) is closed on the client machine. In addition, the Email Manager Web Services must 
be installed and configured on the  Email Manager server. 

1. Run the installer for the Email Manager Client. The installer can be found on the distribution 
media in the folder “Email Manager Client”. Run the application setup.exe to start the 
installation.  

2. In the Welcome screen click Next. 

3. In the License Agreement screen, if you agree with terms in the license, select the “I accept the 
term in the license agreement” radio button and click Next. 

4. In the Customer Information screen, update customer information as required and click Next. 

5. In the Email Manager Client Options screen, select the email client being used and click Next 
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6. In the Email Manager Document Repository screen, select the document repository being used 
and click Next 

7. In the Email Manager Server Information screen, set the value for the Email Manager Web 
Services URL, select the Repository Type and click Next. Enter the URL value as follows: 

o If Email Manager Client for FileNet CS or IS is being installed, set the URL to 
http://<host_name>/ecwwscs50/ecwwscs.asmx?WSDL, replacing the text 
“<host_name>” with the name of Email Manager Web Services Machine. 

o If Email Manager Client for Lotus Notes is being installed, set the URL to 
http://<host_name>/ecwwsp850/ecwwsp8.asmx?WSDL, replacing the text 
“<host_name>” with the name of Email Manager Web Services Machine. 

o Enter the value entered in the registry key into the Implementation Worksheet in the 
section Email Manager Client under eMgrWebServicesURL. 

8. Click Install to being the installation. 

9. For Lotus Notes, see the following section, Lotus Notes Client Configuration, for details on further 
configuration required for Lotus Notes to install the Email Manager Client capture button on the 
toolbar. For Outlook, the Email Manager Client capture button will appear on the toolbar the next 
time Outlook is opened. For GroupWise, the Email Manager Client capture button will appear on 
the toolbar the next time GroupWise is opened. 

The following command line parameters may used with the Email Manager Client installer to simplify the 
installation process for administrators. 

 

Parameter Description 

ECWWEBSERVICESURL  May be used to specify Email Manager Web Services URL that will be used. 
The default value is 
“http://<host_name>/ecwwscs50/ecwwscs.asmx?wsdl“ 

Example: 

msiexec /i "FileNet Email Manager Client 3.7.msi" 
ECWRWEBSERVICESURL="http://my_server/ECWWSCS50/ECWWSCS.a
smx?wsdl" 

INSTALLDIR May be used to specify what folder Email Manager should be installed in. 
The default value is “%Program Files%/\FileNet\Email Manager Client 3.7” 

Example: 

msiexec /i "FileNet Email Manager Client 3.7.msi" 
TARGETDIR="C:\eMgr"  

EMAILCLIENT May be used to specify which email client the software should be installed 
for. The default value is “OUTLOOK” 

For Outlook XP/2003, specify "OUTLOOKXP" 
For Outlook 2000, specify "OUTLOOK2000" 
For Lotus Notes 6.0.3 to 6.5.x, 7.0, specify "NOTES6DXL" 
For Lotus Notes 6.0.2, specify "NOTES6" 
For Lotus Notes 5.0.x, specify "NOTES5" 
For GroupWise specify "GROUPWISE" 
 
Example: 
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msiexec /i "FileNet Email Manager Client 3.7.msi" 
EMAILCLIENT="OUTLOOKXP" 

FILENETREPOSITORY May be used to specify which document repository the software should be 
installed for. The default value is “FILENET_CS” 

For FileNet Content Services, specify “FILENET_CS” 

For FileNet Image Services, specify “FILENET_IS” 

For FileNet P8 Content Engine, specify “P8_CE” 

Example: 

msiexec /i "FileNet Email Manager Client 3.7.msi" 
FILENETREPOSITORY="P8_CE" 

DXLIMPORTENABLED May be used to specify whether the option to import DXL files into Lotus 
Notes should be enabled. The default value is “0”, representing “off”. 

To turn on DXL file import support, set the value to 1. 

To turn off DXL file import support, set the value to 0. 

Example: 

msiexec /i "FileNet Email Manager Client 3.7.msi" 
DXLIMPORTENABLED="P8_CE" 

LOTUSCLIENTDBPATH For Lotus Notes, may be used to specify the client database to use. If set, 
this setting will override the client database specified via the Configuration 
Manager.  

Example: 

msiexec /i "FileNet Email Manager Client 3.7.msi" 
LOTUSCLIENTDBPATH="clientdb.nsf" 

LOTUSCLIENTDBSERVER For Lotus Notes, may be used to specify the Domino server that the client 
database resides on. If set, this setting will override the client server location 
specified via the Configuration Manager.  

Example: 

msiexec /i "FileNet Email Manager Client 3.7.msi" 
LOTUSCLIENTDBSERVER="mailserver" 

TRAYICON For Lotus Notes, may be used to specify whether the client icon should show 
in the task tray to indicate that the client has been loaded. Setting the value 
to 1 will enable the tray icon and setting the value to 0 will disable the tray 
icon. The default value is 1. 

Example: 

msiexec /i "FileNet Email Manager Client 3.7.msi" 
TRAYICON="1" 

/q This parameter may be specified for msiexec (the Windows Installer 
application) if a “silent” install (no user interface is shown for the installer) is 
required. If this mode is being used, if values other than the defaults are 
required for the parameters, those values must be specified. 

Example: 

msiexec /i /q "FileNet Email Manager Client 3.7.msi" 
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TARGETDIR="C:\eMgr" 
ECWWEBSERVICESURL=http://my_server/ecwwscs50/ecwwscs.asm
x?wsdl EMAILCLIENT="OUTLOOKXP" FILENETREPOSITORY="P8_CE" 

 
If command line parameters are required for an installation, the text can also be placed in a Windows 
BAT file to simplify the process of installing the Email Manager Client on more than one workstation.  
 

If an error occurs when using the Email Manager Client, a log file will be created in the current user’s 
“temp” location. The log file is named “errlog37.log” and will contain more detailed information related to 
any error dialogs that are displayed. 

5.2.1 Outlook 2000 Client Configuration 
The language that is displayed in the Email Manager Outlook integration is based on the regional settings 
of the current user. When using Outlook 2000, if the language displayed in Outlook for public folder 
names (such as All Public Folders) is not English, an Email Manager language file must be installed on 
the machine that corresponds to the language specified in the regional settings. The language file 
contains the translated name for “Public Folders\All Public Folders”. As a workaround, the following 
registry key may be created on the machine and set to the label used for “Public Folders\All Public 
Folders” for the language being used: 

Key: HKEY_LOCAL_MACHINE\SOFTWARE\FileNET\Email 
Manager\3.7\Client\OutlookClient\ 

Value: ExchangePublicFolder (string value) 

Set the Data in the key to the translated name for  “Public Folders\All Public Folders”. 

5.2.2 Lotus Notes Client Configuration 
For Lotus Notes, additional configuration is required to complete the installation of the Email Manager 
Client to connect to the correct Lotus Database and add the Email Manager capture icon to the Lotus 
Notes toolbar. 

5.2.2.1 Client Database Registry Keys 
Registry keys must be configured to specify the location of the Lotus Notes database being used for the 
client initiated capture (Database for Email Manager Client). These registry keys may be configured as 
a part of the installation by specifying values for the LOTUSCLIENTDBPATH  and 
LOTUSCLIENTDBSERVER parameters in the installer or by manually setting the values in the registry. The 
following is a summary of the registry keys and values that should be assigned to each key. 

 

Value Type Registry Key Description 

ClientDBServer String HKEY_CURRENT_USER\Software\FileNET\Email 
Manager\3.7\Client\LotusClient 

The Domino 
server that the 
client database 
resides on. The 
full name of the 
server must be 
entered. 
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ClientDBPath String HKEY_CURRENT_USER\Software\FileNET\Email 
Manager\3.7\Client\LotusClient 

The client 
database to use. 
The name of the 
database, 
including the 
path must be 
entered. 

5.2.2.2 Adding Toolbar Button 
In the Lotus client, a toolbar containing a “SmartIcon” must be added to Lotus Notes that will allow Email 
Manager to be opened from within Lotus Notes. The toolbar may either be installed using the toolbar 
install application included with Email Manager Client or may be manually installed. 

5.2.2.2.1 Automated Installation of Toolbar 

To automate the installation of the toolbar, do the following: 
 

1. Close the Lotus Notes Client if it is open. 
2. In the menu, select Start -> Programs -> FileNet Email Manager 3.7 -> Install Lotus Notes 

Toolbar 
3. Open the Lotus Notes Client.  
4. If using Lotus Notes 6.x, the Email Manager components should be added to the toolbar. If using 

Lotus Notes 5.x, follow these additional steps: 
a. To include the Email Manager smart icon in the toolbar, select the menu option File -> 

Preferences -> SmartIcon. The SmartIcon Settings screen showing available icons will 
appear. 

b. In the SmartIcon Settings screen, scroll through the list of icons and find the Email 
Manager Client icon. Drag icon from the left side of the column to the right side of the 
column.  Click OK. 

c. The client icon will now appear on the toolbar of the Lotus Notes Client 5.0. 
 

5.2.2.2.2 Manual installation of Toolbar 

The SmartIcon file (.smi file), can be found in the folder Email Manager Client was installed in. Depending 
on the version of Lotus Notes Email Manager has been installed for, the icon file(s) require are:  

• ecwr6.smi – for Lotus Notes 6.x 

• ecwr5.smi, ewicon.mac, ewicon.bmp, ewicon.gif  – for Lotus Notes 5.x 

For Lotus Notes 6.x, add the toolbar as follows: 

1. Open the Lotus Notes client. 

2. In the file menu select the option File -> Preferences -> Toolbar Preferences…. 

3. In the Toolbar Preferences screen, click on the tab Toolbar. 

4. In the Toolbar tab, click the button Import. 

5. In the Choose SmartIcon Set dialog, locate the Email Manager SmartIcon to install in the folder 
Email Manager was installed in. 

6. Click Open to add the toolbar. 

7. In the Toolbar tab, ensure the Visible option is selected for the newly added toolbar. Click Ok to 
complete the toolbar update. 
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For Lotus Notes 5.x, add the toolbar as follows: 

5. Close the Lotus Notes client. 

6. Copy the files ecwr5.smi, ewicon.mac, ewicon.bmp and ewicon.gif into the folder specified in the 
Notes WinNTIconPath setting, which can be found in the Notes.ini file. The default location for the 
WinNTIconPath folder is C:\Lotus\Notes\Data\W32 

7. Open the Lotus Notes client.  

8. To include the Email Manager smart icon in the toolbar, select the menu option File -> 
Preferences -> SmartIcon. The SmartIcon Settings screen showing available icons will appear. 

9. In the SmartIcon Settings screen, scroll through the list of icons and find the Email Manager 
Client icon. Drag icon from the left side of the column to the right side of the column.  Click OK. 

10. The client icon will now appear on the toolbar of the Lotus Notes Client 5.0. 

 

5.2.2.3 Lotus Citrix Installation Limitations 
Email Manager Client installation for Lotus Notes is only supported when using Desktop Mode. 
Application Publish Mode is only supported if the mail template is being updated to support the Email 
Manager client. This is due to limitations in Citrix and Lotus Notes when attempting to deploy the Email 
Manager Client toolbar. 
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APPENDIX A: IMPLEMENTATION WORKSHEET 
FileNet Content Services 

Setting Value 

FileNet Content Services 
Version 

 

Panagon Desktop Version  

Operating System  

Library System  

Library Server  

Email Manager FileNet User  

 

FileNet Image Services 

Setting Value 

FileNet Image Services 
Version 

 

Panagon Web Version  

Operating System  

Domain  

Organization  

Email Manager FileNet User  

 

FileNet P8 Content Engine 

Setting Value 

FileNet P8 Content Engine 
Version 

 

Operating System  

Object Store  

Host Server  

Email Manager FileNet User  
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Exchange Server 

Setting Value 

Exchange Server Version  

Operating System  

Exchange Server  

Email Manager Exchange 
User 

 

Public Folder for Email 
Manager Client 

 

 

 

 

 

Public Folder(s) for Rules 
Based Capture 

 

 

Lotus Domino Server 

Setting Value 

Domino Version  

Operating System  

Domino Server Name  

Organization Name  

Domain Name  

Email Manager Domino User  

Database for Email Manager 
Client 

 

 

 

 

 

Database(s) for Rules Based 
Capture 
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GroupWise Server 

Setting Value 

GroupWise Domain  

GroupWise Server Version  

Operating System  

Domain Directory UNC Path  

Email Manager GroupWise 
User 

 

NDS Tree  

NDS Context  

Account for Email Manager 
Client 

 

Accounts or Post Offices for 
Rules 

 

 

 

Windows Domain 

Setting Value 

Windows Domain User  

Active Directory?  

 

Email Manager Server 

Setting Value 

Operating System  

Email Manager Server Machine  

Temporary File Folder  

Log File Folder  

 

Email Manager Web Services 

Setting Value 

Operating System  

Email Manager Web Services 
Machine 

 

Web Services URL  
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SQL Server 

Setting Value 

Operating System  

SQL Server Version  

SQL Server Name  

SQL Server IP  

Database  

Email Manager SQL User  

 

Oracle Server 

Setting Value 

Operating System  

Oracle Version  

Host  

Port  

SID  

Host String  

Email Manager Oracle User  

 

Email Manager Client 

Setting Value 

Operating System  

eMgrWebServicesURL  
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APPENDIX B: DOCUMENT CLASS 
CONFIGURATION 
This section describes suggested configurations for document classes in document repositories 
supported by Email Manager. 

FileNet Content Services 
To use Content Services with Email Manager, the following are required: 

• At least one Document Class must be setup. Although it is recommended that a specific 
document class be created for email messages, any existing document class may be used. 

• If metadata of the email message needs to be stored in Content Services, either existing Library 
Properties may be used to store the metadata or Custom Properties may be created. Depending 
on the metadata being stored, is it suggested the Custom Properties have the following attributes: 

 

Email Metadata Panagon Property Type 

Attachment Flag String (1) 

CC Address String (200) (multi-value) 

CC Address/Display String (200) (multi-value) 

CC Display String (200) (multi-value) 

Conversation Topic String (254) 

Email Id String (254) 

From Address String (254) 

From Address/Display String (254) 

From Display String (254) 

Received Date (Local) Date/Time 

Received Date (UTC) Date/Time 

Sent Date (Local) Date/Time 

Sent Date (UTC) Date/Time 

Subject10 String (254) 

To Address String (200) (multi-value) 

To Address/Display String (200) (multi-value) 

To Display String (200) (multi-value) 

 

 

 

                                                      
10 Subject it typically mapped to the FileNet CS “Title” property 
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FileNet Image Services 
To use Image Services with Email Manager, the following are required: 

• At least one Document Class must be setup. Although it is recommended that a specific 
document class be created for email messages, any existing document class may be used. 

• If metadata of the email message needs to be stored in Image Services, either existing Library 
Properties may be used to store the metadata or Custom Properties may be created. Depending 
on the metadata being stored, is it suggested the Custom Properties have the following attributes: 

 

Email Metadata Panagon Property Type 

Attachment Flag String (1) 

CC Address String (239) 

CC Address/Display String (239) 
CC Display String (239) 
Conversation Topic String (239) 

Email Id String (239) 
From Address String (239) 
From Address/Display String (239) 
From Display String (239) 
Received Date (Local) Date 

Received Date (UTC) Date 

Sent Date (Local) Date 

Sent Date (UTC) Date 

Subject String (239) 
To Address String (239) 
To Address/Display String (239) 
To Display String (239) 
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FileNet P8 Content Engine 
To use P8 Content Engine with Email Manager, the following are required: 

• At least one Document Class must be setup.  The default Email class that is created as part of 
Content Engine installation may be used.   

• If metadata of the email message needs to be stored in the Object Store, either existing 
document class properties may be used to store the metadata or custom properties may be 
created. Depending on the metadata being stored, is it suggested the custom properties have the 
following attributes: 

 

Email Metadata CE Property Type 

Attachment Flag String (1) 

CC Address String (254) (multi-value) 

CC Address/Display String (254) (multi-value) 

CC Display String (254) (multi-value) 

Conversation Topic String (254) 

Email Id String (254) 

From Address String (254) 

From Address/Display String (254) 

From Display String (254) 

Received Date DateTime 

Sent Date DateTime 

Subject String (254) 

To Address String (254) (multi-value) 

To Address/Display String (254) (multi-value) 

To Display String (254) (multi-value) 
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APPENDIX C: EMAIL SERVER MESSAGE 
JOURNALING CONFIGURATION 
This section describes how to enable message journaling in Microsoft Exchange 5.5/2000/2003, and 
Lotus Notes 6.x. 

Exchange 5.5 SP1 
This section contains instructions for enabling Message Journaling in Microsoft Exchange Server 5.5 
(Service Pack 1). When Message Journaling is enabled, a copy of all inbound and outbound email will be 
placed into a specified Exchange folder. For a more detailed description of Message Journaling features 
in Exchange Server, please consult the Exchange Server documentation provided by Microsoft.  

Note: the following instructions apply only to Microsoft Exchange 5.5 using Service Pack 1 or higher. 
These instructions do not apply to Microsoft Exchange 2000.11  

To enable Message Journaling do the following: 

1. Create a Public Folder in Exchange Server that will be used to store all incoming and outgoing 
email. Assign appropriate permissions to the folder so that only system administrator may access 
the folder otherwise all users may be able to access the contents of the folder. 

2. Disable local delivery and force the MTA (Message Transfer Agent) to handle the message. Add 
the REG_DWORD data type value No Local Delivery to the 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\ 
MSExchangeIS\ParametersSystem key. Enter 1 in the Data Value field. 

3. To force all Internet messages to pass through the MTA, add the REG_DWORD data type value 
ReRouteViaStore to the HKEY_LOCAL_MACHINE\SYSTEM\ 
CurrentControlSet\Services\MSExchangeIMC\Parameters key. Set the value to 1. (Make sure 
there are no spaces between the words ReRouteViaStore). This string value has to be added to 
only those servers that have the IMS installed locally. 

4. To specify Message Journaling at the server, site, or organization level, add the REG_DWORD 
data type value Per Site Journal Required to the 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\MSExchangeMTA\Parameters 
Registry key. Set the value to 0 for organization-level journaling, to 1 for site-level journaling, or to 
2 for server-level journaling.  

5. To configure the public folder as the journaling recipient, obtain the DNs (distinguished names) 
for each server’s public folder.  

To view the DN: 

a. Go to Start -> Run, and type C:\exchsrvr\bin\admin.exe /r  

b. Click OK. 

c. From the Folders -> Public Folders container, select the journal recipient (the public folder 
name).  

d. From the File menu, choose Raw Properties.  

e. In the Object attributes box, select Obj-Dist-Name.  

f. Copy the DN value in the Edit value box. 
                                                      
11 From Microsoft Knowledge Base Article 239427 (http://support.microsoft.com/default.aspx?scid=kb;EN-
US;q239427) 
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Figure A-1 Sample of HQ Journaling Properties 

 
 

g. Add the REG_SZ data type value Journal Recipient Name to the 
HKEY_LOCAL_MACHINE\SYSTEM\ CurrentControlSet\Services\MSExchange 
MTA\Parameters Registry key.  

h. Set the value to the DN of the journal recipient, which was captured in Step f. 

 

Exchange 2000/2003 
Follow these steps to enable Message Journaling in Exchange 2000/200312. 
 

1. In Exchange System Manager, click Servers.  
2. Click Storage Group, right-click on the mailbox store that Journaling should be enabled for, 

and then click Properties.  
3. On the General tab, click to select the Archive all messages sent or received by 

mailboxes on this store check box, and then click Browse to choose an account for the 
archived messages. 

 

                                                      
12 From Microsoft Knowledge Base Article 261173(http://support.microsoft.com/default.aspx?scid=kb;en-
us;261173) 
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Lotus Domino 6.x,/7.0 
Follow these steps to enable Message Journaling in Lotus Domino 6.x/7.0 

1. Create a mail-in database.. Keep a note of the mail-in name (e.g. “eMgr Journal”) and the 
database path (e.g. “eMgr/eMgrJournal.nsf”). 

2. Create a Domino Server Rule to journal messages. This step is performed using the Domino 
Administrator. 

a. To open the Server configuration document: 

i. Open the Domino Administrator. 

ii. Select the server to administer (File, Open Server…). 

iii. Select the Configuration tab, click on the Messaging node in the tree-view to 
expand it, and then select Configurations to show the server configuration 
documents. 

iv. Select the Domino Server where journaling will be enabled, then click the Edit 
Configurations button (above the server list) to open the Configuration Settings 
document for the server. 

b. To open the server mail rule dialog: 

i. In the Configuration Settings dialog, select the Router/SMTP tab (the 2nd tab).  A 
second row of tabs will appear. 

ii. On the second row of tabs, select the Restrictions and Controls tab (the 2nd 
tab).  A third row of tabs will appear. 

iii. On the third row of tabs, select the Rules tab (the last tab).  The list of current 
rules (if any) will be displayed. 

iv. Click the New Rule button to open the Server Mail Rule dialog. 

c. Journaling can be applied selectively or to all documents.  The following instructions will 
define a simple rule that will cause all messages to be journaled.  However you can 
define more sophisticated rules if required. To create a journaling rule: 

i. Open the Server Mail Rule dialog. 

ii. In the Specify Conditions section, select “all documents” and click Add to 
define the condition. 

iii. In the Specify Actions section, select “journal this message” and click Add 
Action. 
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iv. Click OK to save the rule.  The rule will now appear in the rules list. 
 

 
 

3. Enable Domino Mail-in journaling 

a. To open the journaling tab: 

i. If you have just created a rule, the Configuration Settings dialog will be open.  
Otherwise, Open the Domino Administrator, open the Server Configuration 
document (see above) and select the Router/SMTP tab (the 2nd tab). 

ii. On the second row of tabs, select the Advanced tab (the 4th tab).  A third row of 
tabs will appear. 

iii. If the Journaling tab (the 1st tab on the 3rd row) is not pre-selected then click to 
select it 

b. To enable journaling: 
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i. At the Journaling: prompt, select “Enabled”. 

ii. At the Method: prompt, change the journaling method to “Send to mail-in 
database”.  The prompts in the Journaling page will change to show the Mail 
Destination: prompt. 

iii. Click on the arrow button to the right of the Mail Destination: prompt and select 
your journaling mail-in database from the directory. 

 

 
 

c. To apply the settings: 

i. Click on the Save & Close button to save the configuration settings document. 

 
The changes to the journaling configuration and the rules will not take effect immediately.  The changes 
will take place after the next router configuration update.  This takes place at intervals of approximately 5 
minutes. 
 
To force the rules and journaling to take effect immediately.  If the server is running locally, enter the 
following command at the server console: 

Tell router update config 
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APPENDIX D: EXCHANGE NOTIFICATION 
INDICATOR SETUP 
An organizational form needs to be created in Exchange Server that will be used by Email Manager to 
display the capture icon on messages in a user’s Outlook Inbox. After the organizational form is created, 
depending on the replication settings of the Exchange Server, the capture icon form may take up to 24 
hours to propagate to users. 
 
If an Organization Forms Library does not already exist it must be created 
 
For Exchange 5.5, create an Organizational Forms Library as follows: 
 

1. Open the Exchange Administration Utility 
2. Select the menu item Tools -> Forms Administrator to open the Organizational Forms Library 

Administrator dialog. 
3. Click the New button to open the Create New Forms Library dialog. 
4. Click Ok. 

 
For Exchange 2000, create an Organizational Forms Library as follows13: 
 

1. Open Exchange System Manager.  
2. Click to expand Administrative Groups.  
3. Click to expand Folders.  
4. Click Public Folders.  
5. On the System Manager toolbar, click Action.  
6. Click to select View System Folders.  
7. In the console tree, right-click EForms Registry.  
8. Click New, and then click organization form.  
9. In the Name box, type the name of the folder.  
10. Under Eforms language, click to select the appropriate language. 

 
 
To create the Organizational Form that is required by Email Manager, do the following: 
 

1. Open Outlook. 
2. Make sure the default Outlook mail format is “HTML” mode. If it is not, change it to HTML in the 

screen Tools -> Options in the Mail Format tab. 
3. Create a new form by choosing the menu item Tools -> Form -> Design a Form. 
4. In the Design a Form dialog, choose the “Message” form and click the Open button to open the 

Form Design window (See Figure B-1). 
5. In the Form Design window, click on the Properties tab. Click the Change Large Icon… 

button and browse to the folder that  was installed in. Open the subfolder “Icons”, select the 
icon “FnIDMDS.ico” (select “ObjectStore32.ico” for P8) and click Open. 

6. Click the Change Small Icon… button, choose the icon “FnIDMDSs.ico” (select 
ObjectStore32s.ico” for P8), and click Open. 

7. Ensure the option “Send form definition with item” is not selected. 
8. Choose the menu item Tools -> Forms -> Publish Form As… In the Publish Form As dialog, in 

the “Look In” combo box, select “Organizational Forms Library”. In the “Display Name” field, 
type: “Archived”. In the “Form Name” field, type “Archived”. Click the Publish button to publish 

                                                      
13  From Microsoft Knowledge Base Article 271816 (http://support.microsoft.com/default.aspx?scid=kb;en-
us;271816) 
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the form. If a prompt appears asking whether the option “Send form definition with item” 
should be selected, answer No to the question. 

9. Close the Form Design window. When prompted to save the form, select No. 
 
 

 

Figure B-1 Properties tab in Form Design window 
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APPENDIX E: EMAIL MANAGER LOTUS NOTES 
TEMPLATES 
When creating Lotus Notes databases for use with Email Manager, the database may be created based 
on Email Manager templates. Email Manager templates contain additional views that may assist 
administrators when troubleshooting issues or may be used to extend Email Manager functionality in 
mailboxes.The templates can be found in the Lotus Templates folder on the Email Manager distribution 
media.  

The following templates are included: 

Template Description 

Mailbox Enabler (eMgrMboxEnabler.ntf) Optional items that administrators may want to 
consider adding to Notes mail templates.  

• sample views showing icon change 

• custom icons 

• view for message id (to support processing 
options) 

Mailbox Demo (eMgrMboxDemo.ntf) Sample of standard Note mail template with items 
that are in Mailbox Enabler template. 

For Lotus Notes 5.x, the sample mailbox template 
also contains sample agents that may be used 
forward email to capture databases. 

Cache (eMgrCache.ntf) A template that may be used for the Cache 
database that contains sample views for reading 
diagnostic information created by Email Manager. 

Client  (eMgrClient.ntf) A template that may be used for the Client capture 
database that contains sample views for reading 
diagnostic information created by Email Manager. 

 

Template Installation 
The following is an overview of how to install Lotus Notes templates. The installation process described 
here uses the Notes workspace, the legacy user interface for Notes.  The workspace displays pages 
containing database icons.  Each icon is a bookmark that references a Notes database, either on a 
Domino server or the local filing system.  Using the Notes workspace simplifies the installation process, 
keeping track of local and server instances of templates.  Experienced Notes administrators should use 
their standard template deployment methods. 

To install a template on a Domino Server: 
 

Open the Notes client 
• Open the Lotus Notes client and log on to the Domino server where the templates will be 

deployed. 
 
Open the Workspace 
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• Click the databases folder icon  on the Bookmark bar. 

• Select the Workspace bookmark to open the workspace.  
 
The workspace displays one tabbed page on top and five other workspace pages capped by a tab.  
Each workspace page can hold database icons. 
 
• Select an unused tab page for the installation process.  Right-click, select “Workspace 

Properties…” and enter a label for the tab page. 
 

 
 
Create a bookmark for the template on the local filing system 
• In the Notes client, choose "File-Database-Open..." from the menu.  This will open the Notes 

Open Database dialog: 
 

 
 

• In the Notes Open Database dialog, ensure that ‘Local’ is selected at the Server prompt (so that 
Notes will look for databases and templates on the client’s hard disk, not the server).  Click on the 
"Browse" button (bottom right) to bring up the file selection dialog: 
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• Before browsing for the file, go the “Files of type” checkbox and change the selected type from 
“Notes Database Files” to "Notes Template Files".  Select the file template file (see table above) 
and click on the Select button. 

 

 
 

• When the file has been selected, click the "Bookmark…" button and then click "OK" to add the 
bookmark.  Once the bookmark has been created, click "Cancel" to close the database open 
dialog and return to the Notes workspace.  (Note: This process is only intended to create the 
bookmark.  No databases or templates are actually opened at this stage.)  The workspace will 
now contain a bookmark for the Notes template in the local filing system: 

 

 
 
Copy the template from the local filing system to the Domino server 
• From the Workspace, select the template bookmark you created at the previous step, right-click 

and choose "Database, New Copy...".  This will open the Copy Database dialog. 
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• Select the server and edit the default filename, adding the prefix “eMgr\”, so that all Email 
Manager templates and databases are kept together in an eMgr folder (the eMgr folder will be 
created if necessary).   

• In the “Specify What to Copy” section, select "Database design only" and ensure that the "Access 
Control List" checkbox is NOT checked.  Click OK to create the new template copy. 

• There will now be two bookmarks for the template, the temporary bookmark for the version on the 
local filing system, and a new bookmark for the server template:   

 

 
 
• (Optional)  At this stage you may remove the temporary bookmark for the source file on the local 

filing system (server identified as "Local"). 
• Typically only administrators and designers will need access to the template.  If you need to 

change the default template security, right click on the new bookmark, select Database, Access 
Control and update the access control list.  
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APPENDIX F: CHANGING .NET USER 
In some cases, it may be necessary to change the default user that .Net uses when running .Net 
components (such as the Email Manager Web Services). Procedures for changing the .Net user differ for 
Internet Information Service (IIS) 5.0 and 6.0. 

Either an existing user account may be used for the .Net user or a new account may be created for the 
.Net to use. Note that the user must be a domain user. The following is a summary of known folders that 
the .Net user requires permissions to access. Security should be configured such that all subfolders of 
these folders have the same permissions. The list of folders may differ depending on the machine 
configuration. In addition to the folders below, the user will also require full access to the Temporary and 
Log folders created for Email Manager. 

Folder: %windir%\temp 
Access Type: Read/Write 

Folder: %windir%\system32 
Access Type: Read 

Folder: %windir%\Microsoft.NET\Framework\v1.1.XXXX 
Access Type: Read 

Folder: %windir%\Microsoft.NET\Framework\v1.1.XXXX\Temporary ASP.NET Files 
Access Type: Read/Write on the folder and List Folder Contents on the drive's root folder 

Folder: %systemdrive%\Program Files\FileNet 
Access Type: Read 

Folder: %windir%\Inetpub\wwwroot 
Access Type: Read 

Folder: %windir%\WINNT\assembly 
Access Type: Read 

Folder: %systemdrive%\Program Files\Common Files\MSSoap\Binaries 
Access Type: Read 

If FileNet Content Services is being used, the following permissions are required: 

Folder: %systemdrive%\Program Files\FileNET\IDM 
Access Type: Read 

Folder: %systemdrive%\Program Files\FileNET\Shared 
Access Type: Read 
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IIS 5.0 .NET USER UPDATE PROCEDURE 
See the following Microsoft articles for details on how to create and change the .Net user: 

http://msdn.microsoft.com/library/default.asp?url=/library/en-
us/wss/wss/_exch2k_running_asp_net_on_a_dc.asp

http://support.microsoft.com/default.aspx?scid=kb%3Ben-us%3B315158

http://support.microsoft.com/default.aspx?kbid=317012

 
The following is a summary of how to change the .Net user: 

1. Identify the user that should be used by .Net (either create a new user using Microsoft’s 
instructions or use an existing user). Ensure that the user has access to all the files and folders 
required by .Net. 

2. Navigate to the folder %systemroot%\Microsoft.Net\Framework\V1.1.XXXX\CONFIG 

3. Open the file machine.config in Notepad. 

4. In the <processModel> section, change the userName and password attributes to the 
name and password of the new user account. For example:  
 
userName="DomainName\ASPNETUSER" password="ASPNETUSERpassword". 
 

5. Save the machine.config file. 

6. IIS may have to be reset or the aspnet_wp.exe process may need to be manually terminated 
before the changes take effect. 

By default, password in the machine.config file is entered as clear text, to learn how to encrypt the 
password, see the following article: http://support.microsoft.com/default.aspx?scid=kb;en-us;329290. 

IIS 6.0 .NET USER UPDATE PROCEDURE 
If Internet Information Service (IIS) 6.0 is being used, the following configuration is required: 
 

1. Add the .Net user created above to the IIS_WPG local group. 
2. Open the IIS Manager application. 
3. In the tree view select the application pool for Email Manager, right click and select Properties. 

The application pool can be found in the tree view under <server name> -> Applications Pools. 
4. In the application pool properties screen, in the Identity tab, select the radio button 

“Configurable”, and enter the user name (preceded by the domain name) and password for 
the .Net user created above. 

5. Click Ok to save the settings. 
6. Restart IIS for the changes to take effect. 
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APPENDIX G: PST CONNECTOR UNTAG UTILITY 
In a PST Connector Profile, if the Processing Option “Mark File as Processed” is selected, a tag will be 
added to PST files processed by the PST Connector. The tag may be used to prevent the PST Connector 
from re-processing the PST file at a later date. If a file that has been tagged by the PST Connector needs 
to be reprocessed at a later, a utility included with Email Manager may be used to remove tags from files. 

The un-tagging utility can be found in the Email Manager installation folder and is called Untag.exe. The 
utility is a command line application that accepts as input filenames and folder paths.  

Syntax: 

Untag.exe [\s] filenames 

Description: 

filenames: a list of one or more files that should be “un-tagged”. The file names may include wild card 
characters.  

\s: (Optional) if the parameter \s is included, all subfolders will be search for the filenames specified as 
well. Only subfolders of paths specified as a part of the filenames will be searched. 

Examples: 

Process files with a specific name: 

Untag.exe c:\docs\file.pst 

Process files with a specific file extension: 

Untag.exe c:\*.pst 

Search all sub-locations for files with a specific name: 

Untag.exe \s c:\docs\file1.pst c:\docs\file2.pst 

Process all files in a folder: 

Untag.exe c:\files\*.* 

Process all files in a folder and all its subfolders: 

Untag.exe \s c:\files\*.* 

Because the tags added to files by Email Manager are not visible as a part of the file properties, the tags 
cannot be viewed through the file properties screen in Windows Explorer. Notepad may be run from the 
command line to display the file tags. Use the following command to determine whether a file has been 
tagged as “captured” by Email Manager: 

notepad "<filename>:UFI_CAPTURED" 

where <filename> is the name of the file. 

Use the following command to determine whether a file has been tagged as “processed” by Email 
Manager: 

notepad "<filename>:UFI_PROCESSED" 

If the file has been tagged, Notepad will open and the value of the tag will show in Notepad (the value will 
be either “Y” or “N”). If the file has not been tagged, the following message will show: Cannot find the 
<filename>:UFI_CAPTURED.txt file. 
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APPENDIX H: ERROR HANDLING OVERVIEW 
This section contains an overview of how the system handles various error conditions. 

EXCHANGE CONNECTOR 
The Exchange Connector may either encounter errors when attempting to process an item on the 
Exchange Server or when attempting to add files to the document repository.  

Exchange Server Related Errors 

If an error occurs while processing an item on the Exchange Server that the Exchange Connector cannot 
correct without intervention, the Exchange Connector will do the following: 

• Move the email message to a sub-folder of the monitored location called “eMgr Capture Failed”. 
The item in the location may be examined to determine why an error occurred while processing 
the message. 

• Log an error to the Exchange Connector log file. The log file will contain a reference to the email 
that caused the error, the error number and a description of the error. 

• Log an error to the Application Event Log. The entry in the event log will contain details related to 
the error. 

• Copy the email file to a location on the file system (if this option has been enabled in the 
Exchange Connector Processing Options for Error Items). 

Document Repository Related Errors 

If an error occurs while attempting to add a file to the document repository due to the document repository 
not being available (i.e. the document repository server may be turned off or the network may not be 
available), the Exchange Connector will effectively “pause” until the document repository becomes 
available. 

If an error related to a document repository exception (i.e. a mandatory property in a document repository 
has not been assigned a value), error handling described in the Exchange Server Related Errors section 
will be applied. 

LOTUS CONNECTOR 
The Lotus Connector may either encounter errors when attempting to process an item on the Lotus 
Domino Server or when attempting to add files to the document repository.  

Lotus Domino Server Related Errors 

If an error occurs while processing an item on the Domino Server that the Lotus Connector cannot correct 
without intervention, the Lotus Connector will do the following: 

• Add a message to the “Error View” in the Cache Database with a status code of “256”.  

• Log an error to the Lotus Connector log file. The log file will contain a reference to the email that 
caused the error, the error number and a description of the error. 

• Log an error to the Application Event Log. The entry in the event log will contain details related to 
the error. 

• Copy the email file to a location on the file system (if this option has been enabled in the Lotus 
Connector Processing Options for Error Items). 
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Document Repository Related Errors 

If an error occurs while attempting to add a file to the document repository due to the document repository 
not being available (i.e. the document repository server may be turned off or the network may not be 
available), the Lotus Connector will effectively “pause” until the document repository becomes available. 

If an error related to a document repository exception (i.e. a mandatory property in a document repository 
has not been assigned a value), error handling described in the Lotus Server Related Errors section will 
be applied. 

PST CONNECTOR 
The PST Connector may either encounter errors when attempting to process an item on the file system, 
attempting to process an item in a PST Archive file, or when attempting to add files to the document 
repository.  

File System Related Errors 

If an error occurs while attempting to access a PST Archive on the file system that PST Connector cannot 
correct without intervention, the PST Connector will do the following: 

• Log an error to the PST Connector log file. The log file will contain a reference to the file that 
caused the error, the error number and a description of the error. 

• Log an error to the Application Event Log. The entry in the event log will contain details related to 
the error. 

• Copy the file to a location on the file system (if this option has been enabled in the PST Archive 
Processing Options for Error Items). 

PST Archive Related Errors 

If an error occurs while processing an item in a PST Archive that the PST Connector cannot correct 
without intervention, the PST Connector will do the following: 

• Move the email message to a sub-folder of the current location called “eMgr Capture Failed”. The 
item in the location may be examined to determine why an error occurred while processing the 
message. 

• Log an error to the PST Connector log file. The log file will contain a reference to the email that 
caused the error, the error number and a description of the error. 

• Log an error to the Application Event Log. The entry in the event log will contain details related to 
the error. 

• Copy the email file to a location on the file system (if this option has been enabled in the PST 
Content Processing Options for Error Items). 

Note that if a one or more items in a PST Archive cannot be processed, processing of the PST Archive 
will not fail. The PST Connector will continue to process all other items in the PST Archive. After a PST 
Archive is processed, the error log should be examined to ensure all items within a PST Archive were 
successfully captured. 

Document Repository Related Errors 

If an error occurs while attempting to add a file to the document repository due to the document repository 
not being available (i.e. the document repository server may be turned off or the network may not be 
available), the PST Connector will effectively “pause” until the document repository becomes available. 

If an error related to a document repository exception (i.e. a mandatory property in a document repository 
has not been assigned a value), error handling described in the PST Archive Server Related Errors 
section will be applied. 
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APPENDIX I: LOTUS CONNECTOR CACHE 
DATABASE CODES 
The following is a summary codes that the Lotus Connector may write to the Cache Database. 

Code Description 

1 Queued 

2 Rules Applied 

4 Index template assigned (fits a rule) 

8 Exported 

16 Uploaded to UFI 

32 Stub created (for shortcuts or attachment removal) 

64 Ready for post processing 

128 Post processing completed 

256 Error 

 
The code values are bit flags and can be added together to form the current status. The value of the 
status flag determines which views a document appears in (i.e. Status=1 appear in Queued Items View, 
Status >=256 appear in Error view). The views will only appear if the cache database template included 
with Email Manager (eMgrCache.nsf) was used when the cache database was created. 

To match a reference to an item in the log file to an item in the cache database, the UID (unique identifier) 
for the item is required. The UID will be embedded with the log entry in the log file. 
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APPENDIX J: GROUPWISE TRUSTED 
APPLICATION AND RETENTION 
CONFIGURATION 
Email Manager must be registered as a Trusted Application on the GroupWise server. As well, Retention 
must be enabled in the GroupWise Post Offices and Account that Email Manager will be processing email 
in. The following is a summary of how to enable the Trusted Application and Retention in GroupWise: 

1. Use the Email Manager Configuration Manager to create a GroupWise Source Server instance. As a 
part of the configuration, create a Trusted Application Key by clicking the Generate Key button. This 
will create a Trusted Application reference in GroupWise. 

2. On the GroupWise Server, open Console One. 

3. Select the GroupWise Domain that Email Manager will connect to. 

4. In the menu select Tools -> GroupWise System Operations -> Trusted Applications... 

5. In the Configure Trusted Applications screen, select the Trusted Application (the name should match 
the name entered as Trusted Application Name in the Configuration Manager). 

6. Click the Edit button. 

7. In the Edit Trusted Application screen, the description should read: FileNet Email Manager. 

8. Select the checkbox Provided Message Retention Service. This will enable Retention. 

9. Click Ok. 

10. Right click on the GroupWise Domain and select GroupWise Utilities -> Client Options... 

11. In the GroupWise Client Options screen, click the Environment button. 

12. In the Environment Options screen, select the Retention tab. 

13. Select the checkbox Enable Message Retention Service. 

14. Click Ok. 

 

Note: when using GroupWise 6.5, if Email Manager is being re-installed and a trusted application key for 
Email Manager was previously created, the following error may show when attempting to create a new 
key in the Configuration Manager: 

Error: Failed to login into account Admin : Login unsuccessful and Error: HRESULT=0x80004005, 
Source=Account.Object, Description="Login unsuccessful", 
Message="filenet::emrc::com::COMErrorHandler". 

To work around this issue, change the Trusted Application Name in the Configuration Manager to a name 
that has not been used yet on the GroupWise server. 
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